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In This Guide...

In This Guide...

This guide describes the concepts of Agilent OpenLAB CDS ChemStation
Edition. In the following, the term ChemStation always refers to Agilent
OpenLAB CDS ChemStation Edition.

In this manual we describe the efficient use of the data acquisition,
analysis, and reporting functions in OpenLAB CDS ChemStation Edition
C.01.06 to boost your lab’s productivity.

1 Basic Concepts of OpenLAB CDS ChemStation Edition

This chapter explains the principles of working with ChemStation,
including remote control, the graphical interface and the ChemStation
views.

2 Working with Methods

The method is a vital part of ChemStation, and this chapter explains the
concepts in detail.

3 Data Acquisition

This chapter contains an introduction to the process of acquiring data.

4 Automation/Sequences

This chapter describes the concepts of automation. It explains how to
work with sequences in ChemStation, what happens when a sequence is
run and how to customize sequences.

5 Run Queue and Queue Planner

This chapter explains the concepts of Run Queue and Queue Planner. It
explains how to add single samples, sequences, or pauses to the Run
Queue.
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6 Data Analysis and Review Concepts

This chapter outlines the data analysis and data review options. In
OpenLAB CDS ChemStation Edition, these options are available in two
separate views.

7 Calibration

This chapter explains the concepts of calibration.

8 Reporting
This chapter describes the concepts of Intelligent Reporting and Classic
Reporting.

9 CE specific Concepts and Functions

This chapter is relevant only if you use ChemStation to control CE
instruments.
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1 Basic Concepts of OpenLAB CDS ChemStation Edition

Terms and Abbreviations

Table 1 Terms and Abbreviations used in this document

Term Description

ChemStation OpenLAB CDS ChemStation Edition

EZChrom OpenLAB CDS EZChrom Edition

Data Store OpenLAB Data Store

ECM OpenLAB Enterprise Content Manager
RC .Net

RapidControl .Net Interface

ChemStation Concepts and Workflows



Basic Concepts of OpenLAB CDS ChemStation Edition 1

Introduction

Agilent OpenLAB is a portfolio of laboratory software, which provides an
open architecture and reusable, standardized interfaces. There are
different OpenLAB solutions for each step in the life cycle of scientific
data:

* Chromatographic Data System (CDS)

OpenLAB CDS is available as EZChrom Edition or as ChemStation
Edition. This manual describes the ChemStation Edition.

* Enterprise Content Manager (ECM)

+ Data Store

* Electronic Lab Notebook (ELN)

OpenLLAB CDS provides full instrument control of Agilent's LC, GC, CE,
CE-MS and LC-MS instrumentation. It offers tools for data acquisition,
analysis and interpretation using a multi- technique, multi- vendor
instrument control. You start the chromatography software from the

OpenLAB Control Panel, where you access all functions provided by
OpenLAB Shared Services.

ChemStation Concepts and Workflows 9
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Remote Instrument Control

10

With a distributed system configuration, you can configure and launch
your ChemStation instruments from any OpenLAB Control Panel that is
connected to the OpenLAB Shared Services server.

Launch Instruments

To configure or launch your instruments, you can use the Configure
Instrument, Launch online, and Launch offline buttons in the OpenLAB
Control Panel. As in workstation or networked workstation configurations,
the instrument configuration dialog runs on the local PC. However, with a
distributed system configuration, the ChemStation application itself runs
on an Agilent Instrument Control (AIC) machine, and you access the
application via a Remote Desktop connection to the AIC machine.

The remote ChemStation windows are shown independently of the
OpenLAB Control Panel; you can launch an instrument, close the Control
Panel, and continue working with the instrument. Also you can run
multiple instances of OpenLAB Control Panel on the same client using
different logon credentials. The different credentials will be propagated to
the instruments you launch from the corresponding OpenLAB Control
Panel.

You can identify the instruments running on a remote AIC machine by the
window title, which contains both the instrument name and the AIC name.

Session Disconnect

Instruments running on an AIC are independent of the client from which
you opened the Remote Desktop connection. If the client disconnects, for
example, due to network failure, a sequence running on the instrument
continues unaffected. To regain control over the instrument once the
network has recovered, simply click the Launch online or Launch offline
button again.
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To disconnect intentionally, click on the Close button or select File > Exit.
The Close dialog offers an additional Disconnect button. By disconnecting,
you cut off the Remote Desktop connection while leaving the instrument
running.

You can disconnect the Remote Desktop connection while a sequence is running.

To reconnect to this instrument, simply click the Launch online or
Launch offline button again in the OpenLAB Control Panel. You can
reconnect from any OpenLAB Control Panel that is connected to the
OpenLAB Shared Services server.

If you click Launch offline to reconnect to an online instrument, or vice
versa, you will get two instrument windows, one for the online instrument
and one for the offline instrument.

Session Takeover

You can take over an existing session by clicking the Launch online or
Launch offline button in the OpenLAB Control Panel on a different PC:

* If you launched an instrument from the OpenLAB Control Panel on PC
1, then log on to an OpenLAB Control Panel on PC 2 with the same
user credentials and launch the same instrument there, you simply take
over your existing session and continue on PC 2 with whatever you
started on PC 1.

No warning is shown if the new user and former user have the same credentials.

* If another user has launched the instrument from the OpenLAB Control
Panel on a different PC, and you have the required privileges, you can
also take over that session. You must have the Take over ChemStation
Remote Session privilege, and if the other user has privately locked the
ChemStation, you must also have the Break Session Lock privilege.

If you take over the session, the other user will get a message that you
are going to take over the session. As soon as the other user has
acknowledged this message, the instrument window is closed on this

ChemStation Concepts and Workflows 1
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user's PC and opened on your PC. The other user receives a message
stating which user has taken over the session.

Online and offline instruments are included in the same session and are
therefore always transferred together. If an online instrument and an
offline instrument are already launched in a session, the takeover
transfers control of both instruments, regardless of whether you clicked
the Launch online or Launch offline button. If you click Launch offline
and the session comprises only an online instrument, or vice versa, you
will get two instrument windows, one for the online instrument and one
for the offline instrument.

12 ChemStation Concepts and Workflows
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About the ChemStation Software

Operating System

ChemStation C.01.06 requires Microsoft Windows 7 or Windows 8.1
operating system.

The ChemStation Control Charts feature requires Microsoft Excel.

Central Data Storage

A central data storage system can hold all kinds of electronic data
independent of any proprietary data formats. ChemStation raw data (and
other human-readable documents, such as workbooks) are stored together
with metadata; this allows the data to be searched very easily.
ChemStation methods, sequence templates, report templates, and data files
(sequences and single runs) can be uploaded to the central repository, and
later downloaded back into the ChemStation if required.

Agilent provides two systems for central data storage:

* OpenLAB Data Store is available as a single server solution providing
centralized data management for small to medium laboratories with up
to 30 instruments. It provides the necessary security in support of
regulatory compliance. Please see OpenLAB Data Store documentation
for further information.

* OpenLAB ECM is available as a single server solution or multi-server,
distributed solution for comprehensive data management needs for
laboratories with a few instruments to 100s of instruments. It also
provides the necessary security in support of regulatory compliance.
Please see OpenLAB ECM documentation for further information.

For more information on the concepts of ChemStation with central data
storage, refer to the Agilent OpenLAB CDS ChemStation Edition with
Central Data Storage Concepts Guide.
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Methods and Sequences

The analytical method fully describes how a particular separation is
performed. It contains all parameters for instrument control, data
acquisition and evaluation, including integration, quantification and
reporting. The system may be set up to acquire data from a number of
samples by different methods. The control file for this sort of operation is
called a sequence, and holds the individual sample information, references
to the appropriate methods, and automatic recalibration specifications. For
further information on methods and sequences, see
“Automation/Sequences” on page 71 and the online help system.

System Configuration

The configuration of the instrument system is done through the OpenLAB
Control Panel which starts the configuration editor program. It allows you
to define your instruments, their GPIB or LAN addresses, the directories
for your data, sequences and methods and the initial screen size of the
ChemStation software. In addition, you can activate or deactivate
Intelligent Reporting and 3D Spectral Evaluation, and you can define the
method download options.

Acquisition Method Viewer

With the Acquisition Method Viewer, you can check the acquisition
parameters stored in a method, independently of the current instrument
configuration. You can choose to either apply this method in its original
version to the instrument, or to resolve this method against the current
instrument configuration.

ChemStation Concepts and Workflows
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Method Download Options

The method download options define the behavior of ChemStation, if the
last selected method from the previous instrument session differs from the
current instrument settings. You can choose among the following options:

Download method to instrument

The last selected method is downloaded to instrument. The instrument
settings will be overwritten. This behavior corresponds to ChemStation
revisions C.01.03 or lower.

Upload method from instrument

The instrument settings are uploaded into the last selected method. The
method will be marked as modified.

New method from instrument

The instrument settings are uploaded into a newly created ChemStation
method.

Always ask user to choose an option

At ChemStation startup, a dialog is shown where you can choose on of
the options described above. In this dialog, you can also compare the
instrument settings for each module with the settings in the last
selected method.

When comparing the differences, you can either display the entire list
of settings, or display only the differences.

This dialog evaluates the settings of instruments with RC.Net drivers only. It does not
evaluate settings of instruments with classic drivers.
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Data Model

The ChemStation software is designed around a data model based on a
memory structure called a register. Registers are multipurpose structures
that can hold analytical data and information for both two-dimensional
information (for example, time/intensity) and three-dimensional
information (for example, time/intensity/wavelength).

ChemStation provides commands and functions to construct, expand,
extract and, where it does not alter primary data, edit registers. For
further information, see the online reference in ChemStation under Help >
Commands.

File Naming Conventions

File Names and Tokens

In most of the ChemStation dialogs where you enter a path name or file
name, you can use tokens to dynamically generate suitable names.
Depending on the file or path name that is set in a given dialog, different
tokens are available. In the following screens, several tokens are used as
examples.

The control for file names has the following appearance:
Choose token

Delete content

[<5ampleMames <Dater <Time> X >—|
| E—

Tokens are displayed in blue color and with an underline
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The control for path names has the following appearance:

Choose token

Browse for location

Delete content

|J<Eomputer>x’<lnstNarne>/1 X e b

Tokens are displayed in blue color and with an underline

In each corresponding dialog, the resulting file name or path name is
displayed additionally.

You have the following options to work with this type of fields:

* Add static text.

* Click the Arrow button ( * ) to choose a token from the list.
Press the Arrow Down key to choose a token from the list.

* Right-click one of the tokens already used to replace it by another
token from the list.

* C(Click the X button to delete the current content of the field.

* Click the button with the three dots (*=*) to browse for the required
path.

Naming Conventions

The following rules enable ChemStation to create and process valid names
for files and directories:

The following characters are not allowed as part of a file or directory
name:

<>:"/Nj@%rre

Using these characters in file or directory names may cause problems
when loading files in ChemStation. In addition, if these characters are
used in the installation folder, the reprocessing copy does not start. If the
character % is used in the installation folder, some ChemStation shortcuts
do not work properly.
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The following rules apply in addition:

Table 2  Restricted characters

ChemStation parameter Character

Method file names: % and . (decimal point) are not allowed

Data subdirectory and sequence subdirectory: [] + =, . (decimal point); spaces are not
allowed

Data file names in sequences Spaces are not allowed

The following reserved device names cannot be used as the name of a file:
+ CON, PRN, AUX, NUL
* COMx (where x is a number from 1 to 9)

* LPT1x (where x is a number from 1 to 9)
Also avoid these names followed by an extension (e.g. Nul.txt).
English, Japanese, and Chinese operating systems are used to test naming conventions.

Agilent cannot give a support statement for non-English operating systems and their
special characters.

ChemStation Concepts and Workflows
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Maximum Length of ChemStation file names and subdirectories

The Agilent ChemStation specifications for file names and subdirectories

are listed below:

Table3  Maximum length of ChemStation file names and subdirectories

DataFile/Subdirectory/Path Max. Input  Auto Example
Length append
Data file name of single sample 60 .D Demodad.d
Data file name in a sequence, using 15 .D longname000001.d

prefix/counter

Method Sequence Hypersequence 40 .M

Libraries Customized Report Templates .S
. HYP
.UVL
. FRP

Data file subdirectory 40

Data sequence subdirectory 40

Result Set Name 40

Data Path 100 100

Method Path

Sequence Path

Hypersequence Path

Libraries Path

Customized Report Template Path

def_lc.m
def_lc.s
def_lc.hyp
demodad.uvl
areapct.frp

demo (in sample
information)

demo (in sequence
parameters)

test_date_time (create
using sequence
preferences)

¢:\chem32\1\data
¢:\chem32\1\methods
¢:\chem32\1\sequence
¢:\chem32\1\hyper
c:\chem32\speclib
c:\chem32\repstyle

All ChemStation logbooks report system messages in an extended format
and information strings are printed over multiple lines. Certain reports,
e.g. Sequence report, may truncate filenames to fit all information onto

the report template.

ChemStation Concepts and Workflows
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Software User Interface

The ChemStation user interface is designed into views that group software
functionality according to typical analytical tasks. The following standard
views are present in all software configurations:

* the Method and Run Control view for controlling and acquiring data
from the instrument

* the Data Analysis view for reevaluating data that has been acquired
* the Review view for reviewing the data using specific report templates

* the Report Layout view for designing specific report layouts

Additional views are present if additional data evaluation modules have
been ordered or for certain instrument configurations that support
instrument diagnostics and verification procedures. A ChemStation
Companion view is available for when it is desirable to have instrument
operators run samples from an easy-to-use, preconfigured table.

The Navigation Pane contains the Navigation Button, to allow rapid
switching between the ChemStation views, and the tree-based
ChemStation Explorer. The contents of the ChemStation Explorer are
view-dependent, giving access to different ChemStation elements.

Each view consists of a set of standard user elements including menus
and toolbars. The standard toolbar provides rapid access to the common
system specification information such as methods and sequences. The
Method and Run Control view additionally incorporates a system status
bar, a sample information area, which may be configured for single runs
or automated runs, and a schematic instrument interface diagram for GC,
CE and LC configurations. The schematic instrument interface diagram
uses hot spots to allow rapid access to instrument parameters and an
animated graphical overview of the status of each analysis as it proceeds.
The schematic instrument diagram may be turned off if it is not required,
to save memory and other Windows resources.

The Data Analysis view extends the standard toolbar to specific data
analysis modes including recalculation, reprocessing, integration,
calibration, reporting, annotation, signal comparison and additional
specialized modes if the modules are installed. Each of these separate data
analysis modes are supported with a mode-specific toolset.

The Review view is available if Intelligent Reporting is selected for the
instrument. This view allows you review the data in a very flexible way.
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You can select any combination of data files as a basis for the review, and
apply any existing report template to the selected data. The selected
report template defines the way in which the data is shown and which
type of information is included in the generated report. The toolbar
provides functions for printing and exporting the generated reports.

The Report Layout view allows you to define the layout of a specific
report template or report style. It also uses a set of toolbars specific to
this task. The type of Report Template editor shown in this view depends
on the type of reporting that is configured for the instrument. You can
either use Classic Reporting or Intelligent Reporting (see “Reporting” on
page 175).

Navigation Pane

A Navigation Pane, available on the left side of all ChemStation views, is
designed to speed access to many key ChemStation elements, as well as
enabling quick switching between views. The Navigation Pane contains the
tree-based ChemStation Explorer and a configurable button area. It also
includes an autohide feature so that the ChemStation workspace is not
compromised, and offers standard features such as resizing, and
re-arranging of the navigation button area.

Navigation Buttons

The Navigation Buttons allow the ChemStation view to be switched by
clicking on the specific Navigation Button. The Navigation Button section
can be minimized, expanded and re-arranged.

ChemStation Explorer

The contents of the Navigation Pane are view-dependent. For Method and
Run Control, Data Analysis, Review, and Report Layout, the ChemStation
Explorer allows you to navigate to the different ChemStation elements. By
default, these elements for data, methods and sequences are based on the
configuration editor settings. New nodes for methods, sequences, data

location can be specified using the “Preferences” option in the view menu.
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Table4  Navigation Pane items

Navigation Buttons ChemStation Explorer Elements
Method and Run Control Sequence templates / Master methods, Result Set
methods
Data Analysis Data / Master methods, Result Set methods
Review Data / Report templates
Report Layout Classic Reporting: Master methods
Intelligent Reporting: Report Templates
Verification (LC and LC/MS) Verification view-specific shortcuts
Diagnosis (LC and LC/MS) Diagnosis view-specific shortcuts
Tune (LC/MS) Tune view-specific shortcuts

Data Acquisition

The status of the instrument is continually monitored and updated on the
display, along with the elapsed run time of the analysis both when the
software is a visible window and when it is iconized. The transactions that
occur during the analysis, including any errors and the instrument
conditions at the start and the end of the analysis, are recorded in the
system’s logbook, an extract of which is stored with every data file.

The instrument conditions, such as flow, temperature, pressure and
solvent composition for liquid chromatographs may be recorded and stored
with each data file. These instrument parameters can be displayed and
plotted to testify to the quality of each analysis. The exact nature of the
parameters recorded depends both on the technique and the capabilities
of the configured instrument.

All regular data acquisitions - single samples as well as sequence runs -
are first added to the Run Queue and then started from there. For more
information, see “Supported Workflows” on page 132.

One or more display windows may be used to monitor the data being
acquired by the instrument in real time. The data are displayed in real
measurement units such as mAU, Volts, degrees or bar. The windows may
each show multiple overlaid chromatographic/electropherographic signals
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or instrument parameters, such as pressure. The display default settings
may be adjusted and are remembered by the system so users can set their
own preferred settings as the instrument default. The window has zoom
capability and the cursor may be used to display a specific signal’s
response at any point in time.

During an analysis, the complete functionality of ChemStation can be used
through the offline copy. While acquisition is running, the Data Analysis
part of the online session of an instrument is not accessible, and data
review has to be performed in the offline copy.

A snapshot function is available for users who wish to start processing
data before the analysis is completed. The snapshot has to be taken in the
offline copy of the instrument sessions and is immediately present for
review.

The layout of the signal and status information windows, including the
components of the schematic instrument interface diagram is saved
automatically.

For further information on Data Acquisition, see “Data Acquisition” on
page 63 and the online help system.

Data Analysis

Data Analysis — Display

The Data Analysis view extends the standard tool bar with task-grouped
data analysis functions including recalculation, reprocessing, integration,
calibration, reporting, annotation, and signal comparison toolsets. The
following key graphical operations are possible:

* single or multisignal displays selectable when loading the
chromatogram/electropherogram,

* overlays of chromatogram/electropherogram from different samples,
* subtraction of one chromatogram/electropherogram from another,

* graphical vertical and horizontal alignment of signals to help visual
comparison,

* signal inversion or mirroring to help visual comparison,
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displays of extended peak performance characteristics for specific
integrated peaks,

graphical zoom and scrolling functions,

adjustment of display attributes including selection of tick marks,
baselines, axes, retention/migration times and compound names (you
can also select the font for the RT and compound labels, adjust the size
and orientation of the display, select the display as overlaid or
separated and select scaling factors),

the chromatogram/electropherogram display may include graphical
overlays of instrument parameters depending on the capability of the
configured instrument,

user-defined annotations may be interactively added to the display, with
the selection of font, size, text rotation and color (once defined, the
annotations may be graphically moved, edited or deleted),

copy the display to the Windows clipboard in both metafile and bitmap
format,

a pick mode function to display the values of individual data points in
detector units, and

export of time/intensity digitized points to the Microsoft Windows
clipboard.

Data Analysis — Integration

The ChemStation integrator algorithm is the second revision of a new
generation aimed at improved ruggedness, reliability and ease-of-use.

Data Analysis — Quantification

The ChemStation’s calibration mode of the data analysis view allows
simultaneous display of:

the signal or signals being calibrated with an indication of the current
compound’s retention/migration time window,

the calibration table whose display may be configured from a
comprehensive selection of calibration parameters, and

the calibration curve for the compound being calibrated.
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All the calibration mode windows are linked so that changes in one are
automatically reflected in all the others. This mode allows graphical
selection and modifications of the calibration data.

Quantification is based on %, Normalized %, External standard, External
standard %, Internal standard and Internal standard % calculations
calculated on either peak area or height. Calibrations may be multilevel
and include multiple internal standard definitions. Calibration histories
are automatically saved and can be used to weight the recalibration
calculations.

For information on calibration and quantitation, see “Calibration” on
page 159.

Data Analysis — Batch Review

The following two additional toolsets are available within the Data
Analysis view:

* Navigation Table

* Batch Review

The Navigation Table makes possible several key graphical operations:

* standard table configuration features, such as sorting, drag-and-drop
options, column selection, item grouping to specify a preferred
navigation table configuration

* right mouse click functions to load a signal, overlay a signal, export
data, print reports

* review signal details by expanding a line in the navigation table
* review signals and create ChemStation reports using a specific method
The following key graphical operations are possible in the Batch Review:

* define automatic or manual review and reprocess of (calibrated) data
files

* recalibration of calibration table
* review compound tables of calibrated methods

* create specific batch reports
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Data Analysis — Recalculation

The functions in the recalculation mode allow you to quickly generate
results or reports for any subset of data shown in the Navigation Table.
You can easily generate results for self-assembled data sets, independent
of the sequences the samples were originally acquired in. You can use any
method for recalculation. The method used will be copied to the single
data files (DA.M). No calibration is done during recalculation.

Data Analysis — Reprocessing

The functions in the reprocessing mode allow you to reprocess one entire
sequence, using the methods defined in the sequence table and using the
results of the calibration samples to calculate the sample results.

Data Analysis — Last Results

In this mode, the data file method (DA.M) for each run is loaded. DA.M is
an exact copy of the method which was used for the last data analysis
(during acquisition, reprocessing, or recalculation). The Last Result mode
allows you to reproduce the results of the last data analysis, even if the
sequence method has been changed in the interim.

Reporting

If Intelligent Reporting has been enabled for an instrument, the Review
view is enabled, and the Report Template Editor for the Intelligent
Reporting is visible in the Report Layout view.

With Intelligent Reporting enabled, you can use both Intelligent report
templates and Classic report templates to create single injection reports
and sequence summary reports. If you have the required privileges you
can create report templates for Intelligent Reporting.

With Intelligent Reporting disabled, you can use only Classic report
templates to create single injection reports and sequence summary
reports. If you have the required privileges you can create report
templates for Classic Reporting.
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Utilities and Compatibilities

ChemStation can import and export data files in the andi (Analytical Data
Interchange) chromatography format of the Analytical Instrument
Association (AIA), revision 1.0, copyright 1992. Data import is supported
at compliance level one (sample information and signal data) and data
export at compliance level two (sample information, signal data and
integration results).

ChemStation includes commands and functions to support the dynamic
data exchange (DDE) standard of the Microsoft Windows platform as both
a DDE client and a DDE server. The command set includes commands to
establish and terminate connections, transfer information in both
directions and execute remote functions.

Customization

ChemStation can be customized using a powerful command set. These
commands may be grouped to execute automatically a specific function;
such a group is called a macro. Users writing macros may define their
own variables, build in conditional or looping constructs, perform physical
I/0O including file handling and user interaction, nest their macros and
schedule and exchange data with other MS-DOS or Microsoft Windows
applications.

For more information on customization, see the online reference in
ChemStation under Help > Commands.
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Automation

ChemStation can plan and execute both single samples and multi- method
sequences.

The sequence parameter set may be defined to use automatically generated
files or sequentially numbered files with a user-defined prefix of up to
fifteen characters. The user may select to run full analyses or data
reprocessing only sequences and can also select one of a series of
technique specific shutdown commands or a user-defined shutdown macro
that runs when the sequence terminates either by error or after all the
analyses are completed.

The sequence table, or list of analyses to run, is built in a
spreadsheet-like user interface that allows users to specify vial numbers
and sample names, sample types, analysis methods, sample quantification
parameters including sample amount, a multiplier and dilution factor,
calibration specification, data exchange parameter LIMSID and the number
of repeat injections. Depending on the configured instruments and
modules, more fields will accessible, for example, if an Agilent 1100/1200
LC system includes a fraction collector, the Fract. Start column will appear
in the sequence table. The appearance of the sequence table can be
configured by the user. The user can jump between individual cells in the
table and copy, cut or paste individual cells or entire rows or series of
rows in order to build sequences efficiently and quickly.

Samples may be identified in the sequence table as unknown, calibration,
blank, or control sample types. The sample type determines any special
data evaluation treatment of the sample:

* Unknown samples are evaluated and reported according to the method
specification.

» Calibration samples are used to recalibrate the quantification
component of the method as described below.

* Blank samples are used to evaluate the reference signal for specific
peaks, as defined by European Pharmacopeia. You can print the
signal-to- noise ratio in customized reports. Please refer to the
Reference Guide for details on the calculation and the required data
fields.

* Control samples are evaluated against the limits for each component
defined in the method. If the results lie outside any specified parameter
range the execution of the sequence will be halted.
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Calibration samples may be defined as simple, cyclic or bracketed. Simple
recalibrations mean a recalibration occurs each time a calibration sample
is defined in the sequence. Cyclic recalibrations occur at defined intervals
during analysis of a series of unknowns. In bracketing a series of unknown
samples, two calibration sets are analyzed. The quantitative reports for the
unknown samples are then calculated using a calibration table averaged
between the two calibration sets.

The Sequence Preview functionality allows users to see the order of
execution of the sequence. As soon as the sequence is queued, the
sequence table also shows all samples run by run. The user can select
individual sample entries to rerun or re-evaluate. When re- evaluating data
already acquired users can specify whether reprocessing uses the original
sample quantification data or new data entered in the sequence’s sample
table.

Sequences may be paused to run single injection priority samples by
another method, then restarted without disrupting the automation.
Samples can be added to the sequence table while the sequence is
executing.

Both the sequence and partial sequence tables may be printed.

For more information on sequences, see “Automation/Sequences” on
page 71, and the online help system.

Run Queue and Queue Planner

The Run Queue allows you to automatically run several single samples or
sequences one after another. The first item added to the queue starts
when the data system is ready, unless paused from the queue. You can
add single samples, sequences based on Easy Sequence templates, classic
ChemStation sequences, or pauses to the queue. Also each Run Method or
Run Sequence command automatically adds an item to the Run Queue, and
automatically starts this item in the queue.

Using the Queue Planner, you can prepare a series of single samples or
sequences and save the plan to the file system. To start these planned
samples and sequences, you simply open the plan and add it to the Run
Queue. This function allows you to start lengthy tasks such as overnight or
weekend jobs.

For more information, see “Supported Workflows” on page 132.
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Good Laboratory Practice

ChemStation is developed to internationally recognized design and
development standards and has a number of features specifically to help
users operating in a regulated environment. These features are in the area
of complete method specification and verification that the methods are fit
for their intended use, to check the operation of their system and ensure
the traceability, originality and quality of the data.

Development Process

The Certificate of Validation shipped with each software package
documents the software development and testing steps executed as part of
the development cycle. The development process is registered to the

ISO 9001 quality standard.

Method Specification and Use

* Global methods — the complete instrument and data analysis
specification is stored in one place. Methods include individual
compound range specifications to check that quantification results are
not applied outside the calibrated range.

* The method change history log allows users of a validated method to
automatically record how and when a method was changed. Users may
optionally add a comment reason to the change history log. The change
history log is automatically stored as part of the method in a binary
format. To prevent unauthorized access to the records, it is protected
by the user access scheme, described below. The change history log may
be viewed and printed.

* Limits may be assigned on a compound-by-compound basis in each
method for a number of chromatographic/electropherographic and
system performance parameters, as described in the data analysis
quantification section. Results exceeding these parameter ranges are
used to control the execution of automated sequences as described in
the automation section. They are indicated on the appropriate analysis
report.

* System performance or suitability reports (see the Reporting section
above) provide detailed analysis of the separation quality.

ChemStation Concepts and Workflows



Basic Concepts of OpenLAB CDS ChemStation Edition 1

You can set up different roles and privileges in OpenLAB Shared Services.
The pre-configured roles ChemStation Administrator, ChemStation Lab Manager,
ChemStation Analyst, and ChemStation Operator offer a basis for the roles in
your environment.

Method Robustness

Sequence summary reports (see “Classic and Intelligent Reporting” on
page 177) provide a means to test methods for robustness. With classic
reporting, the extended format reports for user selected criteria are
reported as trend charts and may be used to determine the realistic
operation limits. With intelligent reporting, you can create your own
templates for sequence summary reports including trend charts with limit
lines. These limits can then be incorporated in the method to ensure,
through the analysis of control samples, that the method is operating
within specifications.

System Operation

The ChemStation verification kit, which is part of the standard software,
automatically checks for the correct installation and operation of the data
evaluation parts of the software by comparing results generated when the
test is executed against prerecorded known values. The verification kit
allows users to define their own data files and methods to be the basis of
the test.

Data Traceability, Originality and Quality

The run time logbook provides a transaction log of the complete system. It
also records any unusual events (such as errors or parameter changes
made during a run) as well as the instrument conditions before and after
each analysis. A copy of the relevant logbook extract is saved with each
data file.

The actual instrument conditions, such as pressure, flow, and temperature,
that occurred during each analysis are also recorded if the configured
instrument supports this capability. This data can be subsequently
displayed graphically with the chromatogram/electropherogram to show
the actual instrument conditions during that particular analysis, as well as
being included on the report.
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Methods saved with the data file record the actual method at the time of
the analysis and allow the complete reconstruction of the reported data at
a later date. The method is saved at the completion of all the analytical
steps.

By default, all reports have time stamps and traceable page numbering
(page x of y pagination style). The user may select the level of detail in
each report ranging from simple summary reports to complete system
details.

GLP Save register files, specified as part of the method configuration, save
all the original data, including sample information, data analysis method,
chromatographic/electropherographic signals, instrument conditions,
integration and quantification results, report data and the run logbook in
one checksum protected binary file. This is an uneditable binary format
that ensures the originality of the results. The file includes a revisioning
scheme that indicates if data has been reprocessed.

Control sample types may be defined in the sequence table and used to
automatically check the instrument performance against quality control

sample results when the instrument is running unattended. Results that
are outside the user-specified acceptable range will stop the automatic

execution of the instrument.
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ChemStation Data Structure

Without Unique Folder Creation

This data structure corresponds to the data structure used in ChemStation
revisions B.01.03 and earlier. Sequences, methods and the generated data
files and results are stored in fixed, specified and separated locations. For
example, methods are referenced by name in a sequence and it is the
user’s responsibility to maintain the integrity of methods, sequences, and
data files. Because of this, the long-term archiving of data and
reproduction of results is a tedious task. Users have to document the
chromatogram, results, and associated method; this is the case not only
for regulated labs, but also for some areas of unregulated labs (such as
environmental labs). Without result set creation, this can be achieved only
by printing everything in a report.

However, there may be situations where users may want to store their
data as in ChemStation B.01.03 or earlier and work according to the
corresponding workflows:

* During method development it may be more convenient to have only
one method for both acquisition and data analysis to automatically have
changes available for future acquisition and reanalysis of already
acquired data.

* Customized macro solutions on a ChemStation system that have been
designed for older revisions may require the data, methods, or sequence
to be stored according to the old data organization scheme.

* When ChemStation C.01.06 runs in a lab where there are also systems
still running on ChemStation revisions B.01.03 or earlier, it may be
more convenient to use the same data organization mode on all
systems.
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With Unique Folder Creation

In order to strengthen the association between data files and methods, the
usage of result sets has been introduced with ChemStation B.02.01 (result
sets have been called sequence containers then). If you use a central data
storage system (OpenLAB ECM or OpenLAB Data Store), the complete
result set (sequence/methods/data files/report templates) is transferred to
the central repository as one entity.

<data_file2>.D

< ile1>.
data_file1>.D { o
<data_file3>.D

Z
%g‘)% Sequence Method
%" <seq_name>.S

<seq_name>.B
<seq_name>.log

<
%.
fn,z;‘ Report Templates
“
% <templ_name>.RDL

. P

Result Set

Figure 1 Sequence Acquisition with Unique Folder Creation ON

The methods in the folder Chem32\1\methods serve as master methods.
They remain unchanged during acquisition and data analysis.

Similarly, the sequences in the folder Chem32\1\sequence serve as sequence
templates that can be used to rerun (but not reprocess) a sequence several
times.
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Report Templates in the folder Chem32\repstyle serve as a starting point for
developing your own report templates.

The data storage pattern varies depending on whether single run data or
sequence data is acquired:

1 When a sequence is executed, a new folder is automatically created
(result set) with a unique name in the specified subdirectory. When a
single sample is run, the data file (*.d) is written to the specified
subdirectory.

2 For sequence data, the executed sequence template (*.s) and all the
methods (*.m) involved are copied into the result set. The copies of the
methods are called the sequence methods in order to distinguish them
from the original master methods. If you use Intelligent Reporting, all
involved report templates (*.rdl) are copied into the result set as well.

All sequence-related tasks (for example, acquisition and data analysis)
are performed on the copies of the sequence and the methods.
Therefore, the sequence template and the master methods remain
unchanged for future sequence execution.

Any changes performed on the sequence during sequence acquisition,
for example, adding lines to the sequence table, are performed on the
copy of the sequence file in the result set. The sequence template
remains unchanged.

Similarly, any changes in the method, for example, updates in the
calibration table in case of calibration runs, are reflected in the
sequence methods, but not in the master methods.

While executing the sequence, all generated data files (*.d) are stored in
the sequence data folder, along with the corresponding batch file (*.b)
and sequence log file (*.1og).

3 Each data file contains a copy of the method used to create the run.
The following method information is stored:

The acquisition parameters are saved as ACQ.TXT to ensure the
preservation of the original method parameters for each specific data
file. The parameters can be viewed and printed using the Method >
View Method command.

The complete method, including data analysis parameters, is saved
after completion of the data analysis part as DA.M.
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Working with result sets provides a number of advantages:

Sequence data are not overwritten. Each sequence acquisition stores the
resulting data files in its own result set with unique name.

With the result set concept, the data is stored with all necessary
information needed for data analysis: copies of the sequence file, of all
methods, and in case of Intelligent Reporting also of the report
templates employed with the sequence. The sequence methods can be
changed with sequence specific input and do not influence the original
master method. The result set concept thus strengthens the meaning of
a sequence as a set of data files and methods belonging together for
result creation.

Data recalculation and reprocessing are both available in Data Analysis
view via the Navigation Table.

The result set concept provides the optimal preconditions for the data
exchange with a central data storage system.

Switching Unique Folder Creation ON or OFF

In order to allow working with a data storage concept as in ChemStation
revisions before B.02.01, the Sequence tab of the Preferences dialog box
contains a Data Storage section. Here you can choose between Unique Folder
Creation ON and Unique Folder Creation OFF (see “Preferences - Sequence
Tab” on page 101). Per default, Unique Folder Creation ON is selected. Unique
Folder Creation ON enables the data storage concept as outlined in the
chapter above.

36
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What is a Method?

A method comprises all the parameters for acquisition and data analysis
together with pre- and post-run tasks for a given sample, if they are
needed.

The available methods (*.m) files are visible in the ChemStation Explorer.
For quick and easy navigation, you can add additional method locations to
the ChemStation Explorer selection tree using the Paths tab of the
Preferences dialog box.
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Parts of a Method

A method is identified by a name of up to forty alphanumeric characters.
The file name always has the .M extension to identify it as a method.
Methods are stored as directories that contain individual files relating to
the components of the method.

Each method comprises four components:

* method information,

* instrument control,

* data analysis, and

* run time checklist.

Method Information

This section is used to define descriptive information about the method.

Instrument Control

Defines parameters that control the instrument or its components. With an
LC instrument, parameters, such as mobile phase composition, flow rate,
injection volume, detector wavelength, and so on, control the pump, the
injector and the detector. With a GC instrument, parameters such as inlet
temperature, inlet pressure, packed column flow setting, and so on control
the instrument.

Data Analysis

Defines parameters that control the data processing.
* Signal Details

Defines signals and their properties used for data evaluation.
* Integration Events

Defines timed events that will occur at specific retention/migration
times on a chromatogram/electropherogram. These timed events can be
used to change the way the signal is integrated.
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Peak Identification

Defines data processing parameters associated with the identification of
peaks in the chromatogram/electropherogram.

Peak Quantification

Defines data processing parameters that affect the quantification
calculations which determine the amount or concentration of sample
component corresponding to each peak.

Calibration and Recalibration

Defines data processing parameters that affect the calibration and how
often calibration is done.

Custom Fields

Defines the properties of sample or compound related custom fields
that are available for the method. The custom fields allow you to add
custom information to a sample or a compound in a sample.

Report

With Classic Reporting: defines the format of the report that is printed
after a run.

With Intelligent Reporting: specifies the report template used to
generate the report after a run.

Run Time Checklist

Defines which parts of the method are executed when the method is run.

You can use the run time checklist to:

acquire, store and process data to produce a report,
execute only a portion of the method,

acquire and store data without analyzing it,
reanalyze existing data files,

use your own macros for data analysis, pre- and post-run processing,
and

save the analysis results in a register for GLP purposes.
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Types of Methods

There are different types of methods. Depending on the storage location,
methods are either used as master methods, as a reference within the
result set of a sequence, or as an actual record of the settings used during
data acquisition.

Master Methods

These are methods stored on the computer disk. Stored methods have a
name with up to forty alphanumeric characters followed by the extension
*.M. The master method directories are configured in the Preferences (see
“Path Selection” on page 64).

The Master Method is stored in a methods subdirectory, available in a
Methods node of the ChemStation Explorer, and is not directly associated
with any result set.

Sequence Methods

When a sequence is run (using the option Unique Folder Creation ON, see
“Preferences - Sequence Tab” on page 101), copies of all the master
methods used in the sequence are stored in the result set along with the
sequence data files. These methods are directly linked to the sequence,
and are also used when the sequence is reprocessed. Changes to these
methods are by default not automatically propagated to the master
methods. Changes take effect as soon as the sequence run starts or
continues after a pause. Changes are also propagated to the data file
methods (DA.M) when the sequence is reprocessed, and on any report
generation.

ChemStation Concepts and Workflows 4



2

42

Working with Methods

Data File Methods

A copy of the data analysis parameters is stored as the data file method
DA.M with the data files. The data file method DA.M is automatically
updated after each result generation (data acquisition, recalculation or
report generation). It is also loaded by ChemStation when you recalculate
results in the Last Result mode (see “Last Result Mode” on page 145).

If you use the Save method with Data option in the run time checklist, the
method is stored additionally as run.m in the data file.

In the ChemStation Explorer, you can easily load either a master method
or a sequence method by double-clicking on the method item.
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Creating Methods

Creating a new method always means modifying a master method or
sequence method and saving the modifications. You can either overwrite
an existing method, or save a method as a new master method. Be aware
that when you change a method, the disk version remains unchanged until
you save your changes.

You have a choice of how to create a method. You can create a method to
do either one or all parts of an analysis. For example, you can create a
method to do only data acquisition. When you are ready to analyze the
data and generate a report, you can then modify the method to do these
data processing tasks.

Do not delete the default method (DEF_LC.M, DEF_CE.M or DEF_GC.M). These method files
are used as templates to create new methods.
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Editing Methods

You can edit an existing method using the Edit Entire Method item of the
Method menu. You are guided through all the method dialog boxes and at
the end you can save the method. This process is shown below:

Method on disk
|

Load Method

Method loaded into memory, becomes current method

Select 'Edit Entire Method' from the Method menu

¥
Edit Method

Save Method [As]
|

Save to new name Save to same name

|
Creates new method Overwrites current method
on disk

Figure 2 Editing Method
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Method Parts to Edit

Each method comprises four components that can be edited separately.

Some of the following subsections refer to specific dialog boxes, and some
are generalized descriptions.

* Method Information comprises:
a text description about the method.

* Instrument Control depends on the configuration, and can comprise,
for example:

oven parameters,
injector parameters, and
detector parameters.
* Data Analysis comprises:
signal details,
integration parameters,
quantification parameters,
calibration parameters,
custom field setup parameters, and
reporting parameters.
* Run Time Checklist comprises:
the parts of the method that will be executed.
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Method Directory Structure

Folders

A method comprises a group of files stored in the method directory (*.M).

By default, master methods are stored under Chem32\1\METHODS.
Additional paths for master methods can be added using the preference
settings. Sequence methods are stored in the result set, and data file
methods are stored as DA.M in the data file subdirectory.

Files

Method files with the .MTH extension contain parameter sets and are in
UNICODE format. The file INFO.MTH comprises the method control
parameters.

Method files containing the instrument parameters have the name of the
related analytical module. For example:

Table5  Method file examples

HPCE1.MTH Comprises the acquisition method for the Capillary
Electrophoresis.

ADC1.MTH Comprises the Agilent 35900 acquisition method. If two identical
instruments are configured, the method files are called
ADC1.MTH, ADC2.MTH.

DAMETHOD.REG For data evaluation.

LALS1.REG Comprises parameters for the Agilent 1100/1200 Series
autosampler when a classic modular LC system is configured. The
method files for the other Agilent 1100/1200 Series modules
follow the same convention Lxxx1.reg where xxx is the module
acronym.

AgilentSamplerDriver1.Rapid ~ Comprises parameters for the Agilent 1100/1200 Series

Control.xxx.xml autosampler when a modular LC system is configured. Several
xml files are present for the various parts of the parameters
(indicated by the xxx part of the file name). Similar .xml files are
available for the other modules.

46 ChemStation Concepts and Workflows



Working with Methods 2

Editing Methods in Online Mode

When an online ChemStation is idle, you can edit all parts of a sequence
method. When a sequence is currently running, you can edit all acquisition
parameters and some of the Data Analysis parameters, such as the
settings under Specify Report.

The changes are saved and immediately set into effect for the current run
and all following sequence lines that include the same method. This means
that you can also change the method during a sequence pause or a partial
sequence.

Editing Methods in Offline Mode

You can edit a sequence method in an offline ChemStation, while the
same method is used for a run in an online ChemStation. In this scenario,
you can edit the Data Analysis part in the offline session. Once you save
the changes in the offline session, the changed DA settings will be used
for the next Data Analysis of the current sequence run within the online
session.

Method updates concerning calibration are not taken into account. Also
history entries are not merged, that is, if a method is running in an online
session, and you change it in both online and offline session, the audit
trail of the method will only contain the changes made in the offline
ChemStation.

If the same method is loaded in online and offline ChemStation, you can only edit the
method offline during the sequence run. Method editing in the offline ChemStation is not
possible if the online ChemStation is idle.
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Administrating Methods

Methods Tree in ChemStation Explorer

The Methods Tree in the ChemStation Explorer is divided into two parts.
The upper part shows the methods contained in the currently loaded
result set. The lower part shows the methods in the master method
directories, which you configure in the Preferences dialog.
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Sequence Methods
=-(uf CACHEM3Z) 1IDATAIRLL_L
LI RLLM

IMaster Methods A
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{1 BATCH.M
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() DEMOCALZ.IM
) INFINITY-CHECKOU, ..
[ 150CRAM
(i) ISOPLOT.M
(] LOADTEST.IM
{0 MULTISIGM
1 BURTTY M
Data | methods

Figure 3 Methods Navigation Tree

The currently loaded method is always shown in bold.

By Drag & Drop you can easily copy master methods to sequence
methods. The entire method (DA parameters and ACQ parameters) will be
copied to the result set.

48 ChemStation Concepts and Workflows



Working with Methods 2

Viewing the Acquisition Method

You can access the Acquisition Method Viewer via the menu Instrument >
Acquisition Method Viewer... in the Method and Run Control view. The Acquisition
Method Viewer is available for both Online and Offline ChemStation
sessions.

With the Acquisition Method Viewer, you can check the acquisition
parameters stored in a method, independently of the current instrument
configuration. The dialog shows the instrument configuration at the time
when the method has been saved in ChemStation. Data analysis
parameters are not shown in this viewer. The Acquisition Method Viewer
does not allow the user to make any changes to the loaded ChemStation
method.

The Acquisition Method Viewer shows the method settings in read-only
mode. It does not provide functionality to edit and save methods.

This dialog shows method settings for instruments or modules with RC.Net drivers only. It
does not show method settings obtained from classic drivers.
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Figure 4 Acquisition Method Viewer dialog
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1 Method browser
2 Toolbar
3 Module tabs (It shows method settings, pretreatment settings in a tab-control for all found

modules in the used instrument configuration)

4 Method viewer area
5 Method Name, Injection Source Info
6 Status bar

In the method browser (1), the preferred method path is shown by default.
Click Change Root... in the toolbar to select a different directory.

The toolbar (2) offers the following View Method options:

+ View with Original Configuration.... Load the settings as stored in the
method to the instrument.

* View with Instrument Configuration.... Apply the stored method to the
current instrument configuration. This option is available for Online
instruments only. The stored method might not be consistent with the
current instrument settings; if possible, the settings are then
automatically adapted, otherwise, you can click Resolve Settings and
check the details in the Method Resolution Info dialog. This dialog shows
the list of inconsistencies and the differences between unresolved and
resolved method.
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Method Resolution Info @

List of Inconsistencies:

¥ml schema wersion mismatch (xml wersion: 1.0.3, expected wersion: 1.0.5) -
Upgrade from xml schema wersion 1.0.3 to wersion 1.0.4

Upgrade from xml schema wersion 1.0.4 to wersion 1.0.5

Use Solwvent Types is set but not supported in current configuration

Parameters for Stroke Mode are set, but not supported in current configquration.
Parameters for Compressibility B are set, but not supported in current configuration.
Parameters for Primary Chanhel are not set.

Parameters for Max., Flow Ramp Dowm are set, but not supported in current configquration.
Parameters for Expected Mixer are set, but not supported in current configuration.
Parameters for Channell Solwenht are set, but not supported in current configuration.
TDarama rara Ffar Charnal? S@alrrant ara oo + Fnt et sewartad dm o mrvan t emnfe e et

m

List of Changes:

Operation Change Desciiption o
Changed | ent Ty o o Mo
Deleted Deleted Stioke Mode with value Synchronized
Deleted Deleted Compressibility Mode B with value Compressibility 'alue Set
Deleted Deleted Compressibility B with walue 75 10e-6/bar =
Changed Changed Salvent Compasition from Channel &, Used: Yes, Percentage: 50, Selected: Ch. 1, Mame: . Tppe: Aqueous to Channel A, U...
Changed Changed Salvent Compoasition from Channel B. Used: Yes, Percentage: 50. Selected: Ch. 1. Mame: . Type: Oiganic to Channel B, Us. ..
Changed Changed High Preszure Limit from 1200.00 bar to 600,00 bar
Added Added Primary Channel with value Automatic
Deleted Deleted Max. Flow Ramp Down with walue 10.000 mLAmird il

Figure b Method Resolution Info dialog

Updating DA Parameters in the Master Method

The Update Master Method option is available from the Method menu and
from the context menu of the sequence method in the ChemStation
Explorer. The exact behavior of this function depends on the currently
selected mode. In all cases, this function updates the data analysis
parameters of the target method.

It is important to note that this feature updates the data analysis parameters only of the
target method, and that it overwrites all data analysis parameters.

Updating a Master Method in Reprocess or Recalculate Mode

In this mode, the Update Master Method command is only active for
sequence methods of a result set. You can update the master method that
you referred to when creating the sequence. The precondition is that the
master method still exists in the master methods directory (the master
method must have the same name as the sequence method).
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You can also configure the sequence parameters to automatically execute
this function during each sequence acquisition or reprocessing. For more
information, refer to “Administrating Methods” on page 48.

Updating a Master Method in Last Result Mode

In this mode, the Update Master Method command is active for both
sequences and single samples. You can transfer the current data analysis
parameters to the master method last used for data analysis. This method
is shown in the Analysis Method column of the Navigation Table.

The command is available under the following conditions:

* The method file exists in the given location (that is, the name and the
entire path must match).

* For sequences: The sequence run has been manually analyzed with a
master method (not with the sequence method).

Updating Any Master Method in Last Result Mode

In Last Result Mode, you can transfer the data analysis parameters to any
master method, independently of the master method related to the current
sequence or single run. To update any master method, select Menu > Update
any Master Method ..., and select a method from the Choose Master Method to
update dialog. The data analysis parameters will then be copied to the
selected master method.

Updating Methods

With the Update Methods dialog (see figure below), you can copy methods
from the master method directory to the result set and vice versa. In both
cases, the entire method is copied (DA parameters and ACQ parameters).

You can open the dialog from the Method > Update Methods... menu or from
the context menu of the sequence method in the ChemStation Explorer.
The function is available for result sets in Recalculate and Reprocess
mode.
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Update Methods

Master Methads Sequence Methods
Method @ Last saved Method @ Last saved
-l G#t\Chem324 1, METHODS -l LT CHEM32, 1\DATARLL 1
() BATCH 4j6/2004 &: 10:00 PM [0 fRpRE7 8/3/2010 11:11:50 AM
[:ﬂ [RIDEF_LC 1/1/1970 1:00:00 AM
] CEMOCALL 4J6(2004 6:11:09 PM @
(1) DEMOCAL? 4j6/2004 6:11:19 PM @
[:ﬂ INFIMITY-CHECKOUT  8i31/2009 1:33:10 PM
] 150CRA 2127 /2006 5:29:26 PM
EIJ ISOPLOT 462004 6:18:18 PM
[:ﬂ LOADTEST 4J6[2004 6:18:31 PM
] MULTISIG 46(2004 6: 18:42 PM
EIJ PURITY 4j6f2004 6:18:49 PM
[:Q RL1 8/18/2010 1:33:42 PM
] 5¥SPERF 4J6(2004 6:18:57 PM
EIJ SYSSUIT 4j6f2004 6:19:11 PM
- CADEMO
(] DEMOADC 10/28/2005 2:31:55 PM
m DEMOAFC 11(2]2005 4:06:33 PM
m DEMOFLD 10f28/2005 2:34:05 PM
(] DEMOYWD 10/28/2005 2:34:37 PM
m ESTD 10{13{2005 4:26:57 PM
m IsTD 10f17/2005 3:55:03 PM
(] SPECSO0HZ 10/28/2005 2:34:50 PM

C1Chem321 1 METHODSIDEMO

[] Show anly comman methads
Figure 6 Update Methods dialog

1 On the left side, you see the methods in all master method directories (as configured in the
Preferences).

2 On the right side, you see the methods in the currently loaded result set.

3 For each method, you see the date when it was last saved. The tooltip of the date shows the
method's last history entry.

4 Methods can also be stored in subfolders of the master method directory.

5 Read-only methods have an [R] prefix. The currently loaded sequence method is shown in
italics.

6 Methods that are common for the sequence result set and the master method pool are
shown in a bold font. The methods are matched only by name; if a method name exists in
more than one pool each of the instances will be considered common.

7 You can copy methods between a master method pool and the sequence result set either by
using Drag&Drop or by using the < and > buttons. You cannot overwrite methods that are
marked as read-only.
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Saving a Method as New Master Method

You can save the data analysis parameters from DA.M as a new master
method. However, the DA.M does not contain acquisition parameters. To
provide a valid set of acquisition parameters for the new master method,
you must therefore select another method as a template for the acquisition
parameters (see figure below). The new master method will then contain
your current data analysis parameters from the DA.M, and the acquisition
parameters from the selected template method. The new method will be
created in the folder where the acquisition template method is located.

Save As Mew Master Method
Enter new master method name:
Acqusition Template Method:
Method Last saved =
—}afC Chem32 1\METHODS
-~ L) BATCH 4/6/2004 6:10:00 PM
- [RIDEF_LC 141{1970 1:00:00 AM
-] DEMOCALL 4/6/2004 6:11:09 FM
) DEMOCALZ 482004 6:11:19 PM
-~ [) DGALSTST 41612004 6:15:20 PM
- ) DGCALAS 4612004 6:15:43 PM
-] DGCALOGL 4/8/2004 6:16:00 FM
-] DRCALOGZ 4/6/2004 6:16:11 FM
- DGCALOGE 4{&/2004 6:16:18 PM
-] DGCALOGY 4/6/2004 6:16:26 PM
-] DRCALOQS 4/6/2004 6116:33 FM
-] DRCALOGE 4/6/2004 6:16:40 FM
{1 DGCALPS 4/&/2004 6:16:49 PM
- DGCHPTST 1142005 11:17:51 AM
-~ [) DGCPTEST 4/6/2004 6:16:57 PM
-] DGFLDTST 4/8/2004 6:17:09 FM
-] DGLEAKT 4/6/2004 6:17:20 FM
1) DGNOISE 4/8/2004 6:17:29 PM
- L) DGNPTEST 4612004 6:17:36 PM
- [) DGTHMTST 1/31/2006 10:09:35 AM
-] DEVWDDC 4/6/2004 6:17:53 FM
L) INFINITY-CHECKOUT  8/31/2009 1:33:10 PM
C\Chem3z} 1\ METHODS, o
[ aK ] l Cancel I l Help I

Figure 7 Save as New Master Method dialog
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What Happens When a Method is Run?

The Run Time Checklist dialog box specifies the parts of the method to
execute when a run is started.

There are eight parts to the run time checklist:

pre-run command or macro,

data acquisition,

standard data analysis,

analysis method for second signal (GC only),
customized data analysis,

save GLP data,

post-run command or macro, and

save copy of method with data (RUN.M).

When running a method the specified parts of the method defined in the
Run Time Checklist dialog box are executed.
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Method Operation Summary

The following list shows the flow of the method operation when all parts
of the Run Time Checklist are selected.

1 Prerun Command Macro

Does a task before the analysis is started.
2 Data Acquisition

Does injector program.

Injects sample.

Acquires raw data.

Stores data.

3 Save Copy of Method with Data (RUN.M) - optional by Run Time
Checklist

4 Data Analysis (Process Data)
Loads data file.
Integrates data file.
Identifies and quantifies peak.
Searches spectral library if available.
Checks peak purity if available.
Saves a copy of the method (DA.M) and prints report.
5 Customized Data Analysis
Executes your macros.
6 Save GLP Data
Saves binary register GLPSave.Reg
71 Postrun Command Macro

Does a task after completion of the analysis, for example, generates a
customized report.
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ChemStation status

Postrun macro

Data evaluation

Prerun macro

Prerun -

Working with Methods

Save DA.M
(default with report generation)

Save RUN.M
(optional)

Injection

Raw data
file closed

I
I
I
I
I
I
I
I
I
I
1
I
I
I
I
I
I
I
Y
Status levels

Run method started via ChemStation menu

Figure 8 Method operation

Time

2

The figure below shows an overview of the ChemStation status during the
method operation, where all parts of the Run Time Checklist are selected.

In case of the mode “Unique Folder Creation OFF" no DA.M is generated. For more details
refer to “Preferences - Sequence Tab” on page 101.
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Pre-run Command or Macro (Run Time Checklist)

If a pre-run command or macro is specified, it is executed before the
analysis is started. This part is typically used for system customizing in
conjunction with other software packages.

Data Acquisition (Run Time Checklist)

All parameters are set to the initial conditions specified in the current
method.

If specified the injection program is executed and an injection is made
from the currently defined vial.

The monitor display shows the progress of the analysis including
chromatographic/electropherographic information, and spectral data if
available.

Data are acquired and stored in a data file.

When the Data Acquisition is finished, the acquisition parameters of the
currently executed method are stored as ACQ.txt for the data file by
default.

Data Analysis (Run Time Checklist)

When the stop-time has elapsed, the analysis is finished and all raw data
is stored on the computer’s hard disk. The data analysis part of the
software starts when all the raw data is stored.

Integration

Chromatogram/electropherogram objects in the signal are integrated as
specified in the Integration Events dialog box.

The start of the peak, the peak apex, retention/migration time and the
end of the peak are determined.

Baselines are defined under each peak to determine final peak height
and area.

The integration results are created as an Integration Results list.
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Peak Identification and Quantification

* Using retention/migration times and optional peak qualifiers, the
software identifies the peaks by cross-referencing them with known
components defined in the calibration table.

* By using peak heights or peak areas the software calculates the amount
of each detected component using the calibration parameters specified
in the Calibration Table.

Spectra Library Search (for LC 3D, CE, CE/MS and LC/MS Systems Only,
Available With Classic Reporting)

For all peaks that have UV-Visible spectra available, an automated search
of a predefined spectral library may be done to identify the components in
the sample based on the UV-Visible spectra. See Understanding Your
Spectral Module for details.

Peak Purity Checking (for LC 3D, CE, CE/MS and LC/MS Systems Only)

For a peak with UV-Visible spectra, you can calculate a purity factor for
that peak and store it in a register. Peak purity may be determined
automatically at the end of each analysis as part of the method, if the
Check Purity box is checked when specifying an automated library search
or when selecting an appropriate report style. See Understanding Your
Spectral Module for details.

Print Report

A report is generated with identities and amounts of components detected
in the run.
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Customized Data Analysis

Enables you to run your own customized macros to evaluate your
analytical data.

Save GLP Data

Saves the binary register GLPSave.Reg together with the data analysis
method in the default data file subdirectory. This feature is designed to
help prove the originality of the data and the quality of the individual
analysis.

The GLPSave.Reg binary file contains the following information in a
non- editable, checksum-protected, register file:

key instrument set points (can be graphically reviewed),
chromatographic or electropherographic signals,
integration results,

quantification results,

data analysis method, and

logbook.

These data are saved only if the Save GLP Data feature is activated by
checking the check box in the runtime checklist. You can review, but not
edit, GLP data in the data analysis menu of ChemStation.

Postrun Command or Macro

If a postrun command or macro is specified it is executed after the data
evaluation, for example, copying data to a disk for data backup.
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Save Copy of Method with Data

This is done after data acquisition, and only if Save method with Data is
activated in the Run Time Checklist. It copies the method used for
acquisition to the data directory, named as RUN.M. RUN.M contains DA
and ACQ parameters. It is read-only and thus provides a means for you to
reconstruct the analysis in the future even if the method changes in the
meantime. You can see how changes in the method or in selected
parameters have influenced your analysis, which can help you to optimize
it.

Save Copy of Method as DA.M with Data (ChemStation Default)

Independently of the marked items in the Run Time Checklist, a copy of
the data analysis parameters of the executed method is saved as DA.M
along with the report in the data file. This is done at the end of the
Standard Data Analysis part, and also when you create a report in the
Data Analysis view.
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This chapter contains an introduction to the process of acquiring data.
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What is Data Acquisition?

64

During data acquisition, all signals acquired by the analytical instrument
are converted from analog signals to digital signals in the detector. The
digital signal is transmitted to ChemStation electronically and stored in
the signal data file.

Path Selection

Starting with ChemStation B.02.01, flexible data storage for single runs
and sequences allows you to specify various saving locations without
reconfiguration. The Paths tab in the Preferences dialog box in the View
menu gives you the opportunity to add multiple paths in addition to the
default path C:\chem32\x\DATA (where x is the instrument number). Using
the Add and Remove buttons, existing paths can be simply deleted, or you
can navigate to a selected location and add the path to the new location
into the Preferences. The default path cannot be removed from the list, but
it can be changed in the Configuration Editor.

| Sequence | Signal/Review options || Audit Trail
Sequence templates
C:AChem32W1WSEQUENCEN Add...
Bemove
Data
C:AChem32WTWDATAY Add...
Bemove
Master methods
C:AChem3241WETHODSY Add...
Bemove
I ok 1 [ Cancel ] [ Help

Figure 9 Paths tab in the Preferences dialog
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All newly specified Data Paths are then available for selection in the
Sample Info and Sequence Parameters dialog boxes when performing runs.

3

Sequence Parareters: Local LC @
Ers | Sequence output \
Diata file
Path: C:\Chem3241AD atat - ]
STSTEM
@ Auto Prefix Counter
() Prefis/Counter SIG1 0oooo
Transfer Seftings...
Part of method to wn Shutdown
According to Runtime Checklist - [ Post-Sequence command/macia
Usze sequence table infarmation
W it 0.00 2| minutes after loading a new method Mot ready timeout: 0.00 = minutes,
Usze in sequence On barcode mismatch don't inject Fraction start location:
[] Update master method [data analpsis parameters)
Sequence comment:
[ 0K ] I Cancel I [ Help ]
Figure 10  Data path selection in the Sequence Parameters dialog
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Online Monitors

There are two types of online monitors, the online signal monitor and the
online spectra monitor.

Online Signal Monitor

The online signal monitor allows you to monitor several signals and, if
supported by the associated instrument, instrument performance plots in
the same window. You can conveniently select the signals you want to
view and adjust the time and absorbance axis. For detectors that support
this function a balance button is available.

You can display the absolute signal response in the message line by
moving the cross hair cursor in the display.

Online Spectra Monitor

The online spectra monitor shows absorbance as a function of the
wavelength. You can adjust both the displayed wavelength range and the
absorbance scale.
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Logbhook

The logbook displays messages that are generated by the analytical system.
These messages can be error messages, system messages or event messages
from a module. The logbook records these events irrespective of whether
they are displayed or not. To get more information on an event in the

logbook double-click on the appropriate line to display a descriptive help
text.
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Status Information

68

ChemStation Status

The ChemStation Status window shows a summary status of the
ChemStation software.

When a single analysis is running:

* the first line of the ChemStation Status window displays run in
progress,

* the second line in the status window displays the current method
status, and

* the raw data file name is shown in the third line together with the
actual run time in minutes (for a GC instrument, files for front and
back injector are also displayed).

The Instrument Status windows provide status information about the
instrument modules and detectors. They show the status of the individual
components and the current conditions where appropriate, for example,
pressure, gradient and flow data.

Status Bar

The graphical user interface of the ChemStation system comprises toolbars
and a status bar in the Method and Run Control View of ChemStation.
The status bar comprises a system status field and information on the
currently loaded method and sequence. If they were modified after loading
they are marked with a yellow cogwheel. For a Agilent 1100/1200 Series
module for LC a yellow EMF symbol reminds the user that usage limits
that have been set for consumables (for example, the lamp) have been
exceeded.
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If supported by the configured analytical instruments (for example, the
Agilent 1200 Infinity Series modules for LC or the Agilent 6890 Series GC)
you can display a graphical system diagram for your ChemStation system.
This allows you to quickly check the system status at a glance. Select the
System Diagram item from the View menu of the Method and Run Control
View to activate the diagram. It is a graphical representation of your
ChemStation system. Each component is represented by an icon. Using the
color coding described below the current status is displayed.

Table 6  Colors used to indicate the status of the module or instrument

3

Color Status

dark gray offline

light gray Standby (e.g. lamps off
yellow not ready

green ready

purple pre-run, post-run

blue run

red error

In addition, you can display listings of actual parameter settings. Apart
from a status overview, the diagram allows quick access to dialog boxes
for setting parameters for each system component.

See the instrument part of the online help system for more information on

the system diagram.
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Rules and Alerts

For instrument drivers that support this feature (for example, GC 7890A),
you can choose Instrument > Manage Rules and Alerts... to configure how the
ChemStation will react to specific events during acquisition.

For example, a missing vial or vessel is a common error in
chromatography. The ChemStation may, for example, continue, pause, stop,
or abort a sequence.

The covered events and the possible behaviors depend on the instrument driver.
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Running a Partial Sequence

93

Creating a Self-Assembled Result Set 96

Sequence Log File 98
What Happens When a Sequence

is Run? 99

Sequence Data File Structure 101
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Postsequence Operation 111

Not Ready Timeout (LC and CE only) 111
Wiait Time (LC and CE only) 111

Automatic Recalibration 112
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Cyclic Multiple-Level Calibration Sequences 117
Explicit and Cyclic Calibrations Together 120

Cyclic Calibration Sequences with Bracketing 122

Cyclic Recalibration Sequences with Multiple Vials Containing the

Same Dilution of a Standard

126

This chapter describes the concepts of automation. It explains how to work
with sequences in ChemStation, what happens when a sequence is run and

how to customize sequences.
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What is Automation?

Automation is the unattended analysis of more than one injection.

The sequence part of the ChemStation software allows you to automate
acquisition, data evaluation, and report generation.
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What Are Sequences and Sequence Templates?

74

A sequence is a series of instructions that automates the analysis of
samples. It can be used to automatically inject each sample, and to acquire
and analyze the data according to the method specified for that sample.
Each sample vial in a sequence may be analyzed with a different
analytical method and, thus, use different sets of
chromatographic/electropherographic conditions and evaluation
parameters.

ChemStation introduces two data storage modes, to allow you to choose
the data storage model that matches your workflow. These modes have
influence of the sequence usage:

+ Unique Folder Creation ON
* Unique Folder Creation OFF

Unique Folder Creation ON for consistency of sample data uses sequences as
“sequence templates” that can be used to run the acquisition multiple
times; however, these templates are not used for reprocessing in Data
Analysis. When the sequence template is run, a result set is created,
containing all related files. If the sequence template is reused, a new
result set is created for each reuse

Unique Folder Creation OFF stores all data in one directory. The sequence *.s
files are not used as sequence templates, so re-executing a sequence again
might overwrite present data, if the data directory is not changed from
the user.

The available sequence/sequence templates (*.s) are visible in the
ChemStation Explorer. For quick and easy navigation, you can add
additional sequence/sequence template locations to the ChemStation
Explorer selection tree using the Paths tab of the Preferences dialog box.
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Sequence Parameters

The Sequence Parameters dialog box contains information common to all
sample vials in a sequence. Use this dialog box to:

+ select the data directory using the Path combo box, and

* specify how the sequence processing should be done by choosing
particular part of Methods and Run parameters.

For example, you can choose to either:

* execute the run time checklist,

* do acquisition only, or

* do reprocessing only (for data acquired till ChemStation Rev. B.01.03. or
for data acquired with option Unique Folder Creation OFF).

Sequence data acquired with ChemStation revisions up to B.01.03 or acquired using the
options Unique folder Creation OFF need to be reprocessed using the reprocess option in
the Method and Run Control view.

Sequence data acquired with ChemStation revisions B.02.01 and higher need to be
reprocessed using the reprocess option in the Data Analysis Navigation table.

If the reprocess option is selected, you have the choice to use the sample
data defined when the sample was originally analyzed, or by activating the
Use Sequence Table information check box, you can use updated sample data
by entering new data in the sequence table:

* specify what happens when the sequence is finished using the shutdown
parameters, and

* gspecify if the barcodes should be used in the sequence and how to
handle a barcode mismatch, assuming that a barcode reader is installed
on the system.
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Sequence Table

76

The sequence table determines which methods are used to process the
sample vials and the order in which the data for the vials is acquired and
analyzed. This table also contains information about each sample,
including the name, quantification parameters, and recalibration
parameters.

For instruments that support dual sampling (GC), an additional column
Injector Location (with Front or Back as possible values) is displayed in the
table, and the Dual Simultaneous Injections check box is available at the
bottom:

+ If you select the Dual Simultaneous Injections check box, the system
combines runs and processes two samples simultaneously in each run.
The line numbers are adjusted correspondingly. In this mode, you can
sort the sequence table by Front or Back injector location.

* If you do not select this check box, one sample is processed in each
run. The order of the runs is as displayed in the table. You can
alternate using the front and back injector.

For a description of the columns in this table and how they interact with
information stored with the method, see the online help reference.
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Creating Sequences (Sequences and Sequence Templates)

Use the sequence table to specify the samples, methods, and vials to run
in the sequence. The sequence table lists each sample in the sequence in
the order it will be run and contains the necessary vial, method, and
calibration information for each sample.

Adjusting Columns in the Sequence Table

=

To change the view and content of your sequence table, click = (Column
Chooser) in the sequence table toolbar. Select the columns that you want to
show within the sequence table. Depending on the installed software
packages, additional columns will be available, for example, the Target Mass
column if an LC/MS is installed.

Inserting, Appending, or Deleting Lines

To insert or append a new blank line, or to delete an existing line, use the
corresponding buttons in the toolbar:

JE (Insert Line)
—lk (Append Lines)

?' (Delete Lines)
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Using the Filldown Function

If you have many samples that use the same method, you can quickly
enter these samples into the Sequence Table using the Filldown icon E
This feature copies the method name, vial range, number of injections per
vial, and if specified, the Sample Amount, ISTD Amount, Multiplier, and
Dilution. The system then enters the information for each vial in the range
into the sequence table.

With the Filldown Options ﬁ, you can specify the exact parameters for the
filldown function.

In addition, you can use the Insert/Filldown Wizard —1‘:" to add a range of
selected lines multiple times to the sequence table.

Filtering the Sequence Table

With the Filter Options ﬁ, you can apply a set of conditions to display a
subset of lines in the sequence table.

Reading Bar Codes

If you instrument supports reading bar codes, click Read Bar Codes to
get the sample names.

Using the Custom Fields Button

If custom fields have been set up in the method(s) used in the sequence
table, select the Custom Fields button in order to edit the custom fields
values for each sample (sample related custom fields) or for each

compound in the method of a sample (compound related custom fields).
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Previewing the Sequence

With Sequence Preview @, a dialog opens that shows the sequence exactly
as it will be executed, with all repeat calibrations, QC samples and blanks
included in the correct order.
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Easy Sequence

Overview

Easy Sequence is a user interface for quick and easy setup of sequences
from templates. The template specifies parameters that should be viewed
or edited by the user. Calibration setup provides an easy to use drag and
drop interface to specify calibration types and sample positions, and
displays an overview of the sequence. With Easy Sequence users can quickly
create sequences following a certain pattern that differ in the number of
samples, but are otherwise similar.

Instrument Cortrol | Run Oueue | Easy Sequence | Easy Sequence Setup
Easy Sequence Setup I‘r:tﬁ Sequence I.g ‘ ‘ dé gé a j @

Easy Sequence Setup: C:\Chem324,2 SEQUENCE' Test Seq.est

Method Information Data Information
Methad: |DEF_LC‘M | Data Location: |C:\Chem32\2\DATA\ |
Estimsted Cycle Time: [10 | min Data File Name: |Datafle_<c> |

Sample Information

Starting Vial Location:
Injection Yolume: |Use Method -

Sample Name: [Sample_<C3> x|

Fill Samples Clear Sample Lisk

| Impart Samples. .. @ =

sample List |

wial | Sample Mame | Inj Yolume | Sample Infa
*1  Sample_DO01  Use Method
2 Sample_0002  Use Method
3 Sample_0003  Use Method
4 Sample_0004  Use Method
g Sample_0005  Use Method
6 Sample_0006  Use Method

| e SenusnTETTE j‘ | e Add to Quete a| | gl ar il |

Figure 11  Easy Sequence tab
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Using Easy Sequence Tab (Sequence)

Easy Sequence tab is used to create a sequence from the template created
in the Easy Sequence Setup tab. Samples saved as a CSV format can also be
imported.

To define a Sequence
1 From the Easy Sequence tab, open a template by clicking on the Open Easy
Sequence Setup icon.

2 Make updates if required. This may include sample vial locations,
calibrant vial locations, data, or sequence location. Parameters available
for editing depend on the template configuration.

3 If the pre-filled samples do not match new sample locations, click Fill
Samples to refill the table.

4 Click Preview/Print Sequence... to preview the Sequence

b5 Save the sequence.

The sequence can be edited as long as its status is Pending in the queue.

6 Click Save and Add to Queue to submit the Sequence to the Sequence
Queue.
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To import Sample Data

Sample data set can be imported into Easy Sequence. Before importing
samples, the CSV file must be set up and formatted properly. Refer to
online help for more information on how to create a CSV sample data file.

1 From the Easy Sequence tab, open a template by clicking the Load Easy
Sequence Setup icon.

2 Click Import Samples...
3 Select the CSV file you want to import.
All valid fields are imported.

To import sample data to the Back Sample List, make sure that the Back Sample List is
selected and displaying before pressing the Import Samples button.

4 Verify the fields by reviewing the Sample List.
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Using Easy Sequence Setup Tab (Template)

Easy Sequence Setup is used to create templates which are the starting point
for creating sequences. There are two panels: Samples and Calibration. The
Samples panel specifies the method, sample, data, and sequence
information. The template is also used to specify what parameters are
hidden or read-only. The Calibration panel provides a graphical interface to
configure and view calibration runs. It provides an easy-to-use drag and
drop interface to specify calibration types, cyclic and bracketed, and
sample positions.

Creating an Easy Sequence template:

1

00 N o o1 &

From the Easy Sequence Setup tab, select the Samples panel. Open an
existing template or create a new template.

Select the Method. Dual injection options will be shown if the method's
injection source is Dual. A back analysis method can be specified for
the back signal. The method is the only parameter required for a
template.

If desired, enter the estimated duration (in minutes) of a sample run.
This is the time measured from when a sample starts to when the next
sample starts. This parameter is used to estimate the total expected
duration of your sequence. Leave this field blank if you do not want to
use the Estimated Cycle Time feature.

Specify the Starting Vial Location, Number of Samples, and the Sample Name.
Select the Data Location

Select the Sequence Location and specify the Sequence Name.

Enter any comments for the template.

Specify which parameters are hidden or read-only. Enter a default
value for injections/vial, sample amount, ISTD amount, injection volume, etc.
This helps to minimize the chance for errors when creating a sequence
in the Easy Sequence Tab.

Save the template.
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Prerequisites

84

To define Calibrations:

The method used in the template should have been calibrated to the necessary levels.

1
2

From the Easy Sequence Setup tab, select the Calibration panel

Select Cyclic, Bracketing, or Simple Calibration from the Calibration Mode
drop down list.

The Sequence Diagram has the following sections:
Sequence Start
Bracketing/Cyclic
Samples/Injections
Sequence End

In the Samples area for the Sequence, set the Calibration Interval based on
number of samples or number of injections.

Setup the Sample type, Blank, Calibrant, or QC Sample by dragging the icon
from the Sample Type area to the Sequence Diagram section.

Setup the parameters for each Sample type and set to Hide or Read-Only.

7 Verify the calibration mode in the Easy Sequence Overview.

8 Save the template.
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Working with Sequences (Sequences and Sequence Templates)

Sequences (Sequences and Sequence Templates) are accessed and created
from the Sequence menu. Sequences may be created and saved in the

same way as methods. When you save a sequence, a file is created with a
.S extension. When you want to edit or use the sequence again, you access
it by, for example, using the Load Sequence item in the Sequence menu.

Data Acquisition in a Sequence

In order to run a sequence, appropriate pre-defined methods must be
available. These are the master methods as outlined above. Typically,
master methods and sequence templates are worked on in the Method and
Run Control view of ChemStation. For this reason, in Method and Run Control
view, the ChemStation Explorer provides access to master methods and
sequence templates.

The sequence template references these methods in the sequence table.

As explained previously, when a sequence is run with sequence template
<sequence_name>.S, and the master method <method_name>.M is used, a
new folder is created that contains all resulting files from the sequence
run (“result set”).

The location of this folder is determined by the settings in the Sequence
Parameters dialog box; the naming of this folder is determined by the
Sequence tab of the Preferences dialog box. By default, the name is
<SeqName> <Date> <Time>, but it can be configured by using tokens, or
you can manually enter any name. For more information on using tokens,
see “File Names and Tokens” on page 16. You can use the following
tokens:

* Current date

* Current time

* User name

* Instrument name

+ Sequence name
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+ Counter

+ Computer name

If the Name Pattern would not result in unique names for the result sets,
ChemStation will append a counter to ensure uniqueness.

Preferences §|

Paths

[rata storaoe

Signal/Review options | Audit Trail

(%) Unigue folder creation OM

Creates a unigue data folder for each sequence un. See Help for more details.

() Unigue folder creation OFF

Stores data az in ChemStation B.01.03 or earlier. Thiz mode does not take adwantage of the latest
data review and reprocessing functionality in ChemStation

Mame pattern
<Segh> <Date> <Time> [:]
SIMO7 2010-10-03 13-59-33

I ok H Cancel ][ Help

Figure 12 Preferences dialog / Sequence tab

At the start of an acquisition sequence, the method specified in the
sequence table is copied from the master methods folder into the result
set. In addition, a copy of the sequence is created and placed with the
sequence log and the batch (*.b) file in the result set. All updates of the
method (for example, updates of the calibration table) are written to this
sequence method in the result set. If you use Intelligent Reporting, the
report templates you selected in the Sequence Parameters or in the
Method Properties are also copied to the result set. All necessary files are
now available for future data review and reprocessing, without changes
that were applied to the master method or sequence template for other
sequence runs.

During acquisition, the data files are stored to the result set. Within each
data file (*.D), a copy of the sequence method is saved for this specific
run. The file ACQ.txt contains the acquisition parameters of the sequence
method, preserving the state of the method as it was at the time of
acquisition of the specific data file. The folder DA.M contains a copy of
the data analysis parameters used in the sequence method.
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With these files saved in the sequence folder, all data review and
reprocess activities can be performed without altering the master method
or the sequence template. If needed, method changes can also be saved to
the master method again.

The result set must always contain the complete set of all data files (*.D). If you delete part
of the data files, uploading the result set to central data storage will cause problems. If you
need to shorten a sequence, create a self-assembled result set from the reduced set of
sequence lines (see “Creating a Self-Assembled Result Set” on page 96).

Data Acquisition of Single Runs

For single runs, the data file is saved directly into the respective
subdirectory. Since only one method is employed for a single run, this
method does not need to be copied into the subdirectory; all actions are
performed directly with the master method. After the acquisition part of
the method is completed, a copy of the acquisition parameters is saved
into the file ACQ.txt. A copy of the data analysis parameters is saved into
the data file directory (DA.M) after the data analysis part of the master
method has been executed.

Automatic Update of Master Methods

With this function, ChemStation automatically updates the data analysis
parameters of the master methods that you copied into your result set.
You can use this function for example to update the calibration tables of
master methods after reprocessing a sequence with recalibrations.

You can activate this function in the Sequence Parameters dialog (see figure
below). During acquisition, ChemStation updates the data analysis
parameters of the master methods for all sequence methods in the result
set.

The data analysis parameters of the master methods are also updated
after reprocessing the sequence. The precondition is that the
corresponding master method (a method with the same name as the
sequence method) still exists in the same master methods directory as at
the time it has been copied to the result set.
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Sequence Pararneters: Local LC @
Sequence parameters ‘ Sequence output
[Drata file
Path [C:\Chem32\1 Datal, -
SYETEM
Subdirectory -
@ Auto Prefis Counter
() Prefis/Counter SIGT 0oo0m
Tranzfer Settings..
Part of method to run Shutdown
According to Runtime Checklist - [7] Past-3equence command/macro
Use sequence table infarmation
‘i ait 0.00 2 minutes after loading a new method. Mot ready timeout; 0.00 2 minutes.
Use in sequence On barcode mizmatch don't inject Fraction start location
u, .
< [7] Update master method [data analysis parameters]
[Tauzgge comment:

[Coc ) [ oo | [ v ]

Figure 13  Update master methods option in Sequence Parameters dialog

As this function will cost performance, it is not advised to use it if you have sequences with
hundreds of methods.

Priority Samples

A currently running sequence can be paused after the current method is
completed. The sequence can be paused to allow the analysis of a priority
sample by the same or another method. The sequence can then be
resumed, where the sequence continues with the sample at which the
sequence was paused.
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Sequencing with Control Samples

Control samples can be specified in the Sample Type field of the sequence
table. The method used to analyze the control sample must contain a
calibration table where control sample limits for one of the compounds are
specified. If the control sample limits you specified are exceeded, the
sequence is stopped and a message is written into the logbook. If you are
using one of the ChemStation report styles, the control sample limits are
also printed on the reports generated for these analyses. For more
information on how to define a sequence with control samples, see the
How To section of the online help.

Sequencing with Blank Reference Samples

Reference signals are required to evaluate the signal-to-noise ratio as
defined by European Pharmacopeia. You can specify the reference data file
in the sequence table by choosing the sample type Blank for the
corresponding samples.

If you use multiple reference files, the order of the files is essential.
ChemStation uses one reference file for all successive runs, until there is
new reference file given in the sequence table. The reference file of a
blank sample serves as its own reference. The following overview shows an
example of a sequence containing two blank samples:

Table7  Example for a sequence with blank samples

Sample Data file Reference file

1 Samplel DF01.D

2 Blank1 DF02.D DF02.D
3 Sample2 DF03.D DF02.D
4 Sample3 DF04.D DF02.D
5 Blank2 DF05.D DF05.D
6 Sampled DF06.D DF05.D
7 Sampleb DF07.D DF05.D

Please refer to the Reference Guide for details on the calculation of the
signal- to- noise ratio.
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Running a Sequence

As soon as you submit a sequence to the queue, the sequence template
changes to a run-by-run list. It shows the sequence exactly as it will be
executed, with all repeat calibrations, QC samples and blanks included in
the correct order. The generated sequence file will be stored in the result
set.

Adding lines to a running sequence leads to inconsistencies in the naming of data files.

Deleting lines from a running sequence can lead to serious inconsistencies, especially if
the sequence is paused and then restarted.

Example: Sequence With Multiple Injections

SEES HEES B +EE~~ T EO

ang?aptlzn Sample Mame Method Name Inj/Loc Sample Type Cal

P 1 Viell | Samplel [aTRiaC - B Semple -

Line

Figure 14  Sequence template before submitting to the queue, sample with 3 injections

SEES BE BRI BB +EEN- T T O

[ Sample

Line oty Sample Mame Method Name Inj/Loc Sample Type Cal
o1 [ [Samgen [aTRIeL B [ Sample -
2 Wial 1 Samplel ATRIAL - (1 Sample -
3 ial 1 Samplel ATRIAL -1 Sample i
4 - -

Figure 15  Sequence file after submitting to the queue, 3 separate lines
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Working with Sequences (Sequences and Sequence Templates)

Example: Sequence With Cyclic Calibration

SNEESES R B BE Wad S EEn- SR 0

I5TD1 157D

Line Enagn;!sn ‘ Sample Mame | tdethad Mame Inj/Loc | Sample Type Cal Level | Update RF ‘ Update RT E:nlarva\ Sample Amount AaI A
1 Wial1 Calibration 1 BRACEK, ~ |2 Calibration ~ |1 Bracket = | Replace ~ |3
2 Wial 2 Calibration 2 BRACK |2 Calibration |2 Bracket « | Replace |3
3 Wial 10 Sample A BRACK - |1 Sample - - -
4 Wial 11 Sample B BRACK - |1 Sample - - -
| - ample C BRACK -~ |1 Sample - - -

« 1 b

’ B sl ][ oK ]l Toredl H Apply l

Figure 16  Sequence template before submitting to the queue, cyclic calibration with
bracketing

SEES B E RS RS +EEN~ B H ‘
Line Eg;n;!zn | Sample Mame ‘ Method Mame Inj'Loc | Sample Type | Cal Level | Update RF | Update RT Eﬂarval | Sample Amaunt l’-\SnIDDuLt lﬁSrIEu
1 1 1
2 “ial 1 Calibration 1 BRACK. - |1 Calibration - |1 Bracket = | Replace -1
3 Wial 2 Calibration 2 BRACK. - |1 Calibration - |2 Bracket = | Replace -1
4 Vial 2 Calibration 2 BRACK ~ |1 Calibration -~ |2 Bracket ~ | Feplace -1
5 ial 10 Sampls A BRACK ~ |1 Sample - - -
[ Wial 11 Sample B BRALCK. -~ |1 Sample - - -
F Vial 12 Sample C BRACEK, =~ |1 Sample - - -
8 Wial 1 Calibration 1 BRACEK. - |1 Calibration - |1 Bracket = | Feplace -1
9 Wial 1 Calibration 1 BRALCK. - |1 Calibration - |1 Bracket = | Feplace -1
10 Wial 2 Calibration 2 BRACK. - |1 Calibration - |2 Bracket = | Replace -1
b1 Wial 2 Calibration 2 BRACK. - |1 Calibration - |2 Bracket = | Replace -1
< I ] b
’ Save and Fun ] I ak ] i Cancel ] [ Lpply ]

Figure 17  Sequence file after submitting to the queue, cyclic calibration with bracketing
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Pausing a Sequence

The currently active run will be completed before the sequence pause.

During a sequence pause, the sequence table file name and the data file
name cannot be changed. In the sequence table you can only change
sequence lines that have not already been executed or change the vial
number in the current sequence line. You can add, delete, and change
sequence lines for future analyses.

For example, it may be necessary to edit an active sequence to add a new
batch of samples. You can edit the sequence so these vials will be the next
sample that ChemStation will process after the samples in the currently
running sequence line.

Stopping a Sequence

The currently active run will be terminated immediately. However, the
data analysis will still be executed for this run. A stopped sequence can
never be resumed.

If you want to finish the current run before stopping the sequence, pause
the sequence, wait for the run to be finished, and then stop the sequence.

Aborting a Sequence

The abort function terminates a currently active sequence immediately. No
Data Analysis is executed.
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Running a Partial Sequence

Result Set Selection for Partial Acquisition

If you use Unique Folder Creation ON (see “Preferences - Sequence
Tab” on page 101, you can choose between the following options for a
partial sequence acquisition:

* acquire the partial sequence into a new result set

or

* acquire the partial sequence into an already existing result set.

Acquiring the data files from a partial sequence execution into an already
existing result set may be useful in the following scenarios:

* A single data file (or several data files) has to be overwritten, for
example, because an incorrect vial was used in the first place.

* Only the first part of the sequence has been executed in the first place,
and the missing samples have to be added by executing partial
sequence. This may occur in the case of an instrument failure during
sequence acquisition.

* Additional lines have been appended to the sequence template after
acquisition of the already existing lines. The additional runs are to be
added to the already existing data.

Deleting lines from or inserting lines into the already acquired part of the sequence
template will lead to serious inconsistencies in the naming of data files.

Therefore, when you select Partial Sequence from the Sequence menu, a
dialog will come up providing you the option to either select an existing
result set from a list or to create a new result set.
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Partial Sequence 2
Choosge a result et for partial acquisition. Choose ‘New' to create a new result set,
Directory Date Mumber of data files
g CACHEM3ZVIADATANE_RLT B/24/2010 3:15:14 &M 5
g CACHEM3ZVIADAT AV _RLT 8/24/2010 3:11:33 &M 4
g CACHEMBZVTADATANRLY 2 84642010 Z:41:03 P 1

Figure 18  Partial Sequence dialog

However, in order to maintain consistency of the result set (so it can be
completely reprocessed in Data Analysis), only those result sets are offered
for partial acquisition that fulfill certain conditions:

The name of the sequence template (source sequence) and the name of
the sequence *.S file in the result set (target sequence) are identical.

Both the data path and the subdirectory have to be identical for the
sequence files.

The number of sequence lines in the source sequence must be equal or
higher than the number of sequence lines in the target sequence.

For each line in the target sequence the sample type and the number of
injections must be identical to the values in the corresponding lines of
the source sequence.

The data file naming scheme must be identical for the two sequence
files.

After leaving this dialog with Ok (for selecting one of the existing result
sets) or New (for creating a new result set), you can select the sequence
lines to be executed during partial sequence.
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Selection of Sequence Lines for Partial Sequence Acquisition

The system displays the Partial Sequence dialog box and allows you to select
individual samples from the table for analysis. This dialog opens
independently of the Unique Folder Creation setting.

A single run is shown on each line of the Partial Sequence dialog box. For
each run, the vial, method, data file, and sample name are given.
Additionally, encoded information about the sequence table and any
calibration samples is shown in the Seq Tbl and Calib:RF:RT columns. See
the online help for an explanation of these codes.

You can obtain a paper copy of the partial sequence by selecting the Print
button.

With Manual update ..., you open the Update Methods dialog box, which allows
you to manually synchronize the master methods and the methods used in
the sequence template. With the Automatic update for selected runs option, you
can update all sequence methods that are used in the selected runs with
their corresponding master methods.

Both acquisition and data analysis parameters are updated.

For example, the Partial Sequence dialog may look like the following. You
can mark specific samples for processing.
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: =
Partial Sequence =
Select the parts of the sequence to un. || eV ‘
Method update befare start
[] Automatic update for selected runs
Exists Sample name Data file Fiun Location Methad Seq thl Calit:RF:RT
] samplel Hy--0707 1 AL o
] sample2 My--02001 2 RL1 001
] sample3d Hy--0307 3 AL 0z
] sampled Hy--040071 4 RL1 04:01
sampleS Hy--05071 5 ALZ 0z:01
Run Sequence ] l Cancel ] [ Help ] [ Print

Figure 19  Partial Sequence dialog box

Creating a Self-Assembled Result Set

Using the Sequence > Create New Result Set command in the Data Analysis
view, you can create a new self-assembled result set from the data
currently shown in the Navigation Table. Self-assembled result sets are
helpful, for example, in the following scenarios:

* You want to combine single samples, sequences, or a combination of
both in order to reprocess them with a specific method.

* You want to shorten a sequence.
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To assemble a new result set

1 Add the required data files into the Navigation Table.

2 In the Navigation Table, select all the data files that you want to
include in your new result set.

3 Select Sequence > Create New Result Set to open the Create New Result Set
dialog box.

4 Select a method to be associated with the new result set.
Specify a folder for the new result set.
Sort the samples.

The names of output data files are automatically updated. If required,
you can restore the initial order of the samples using the [=] (Restore
initial order) button.

Note that the position of a blank file is relevant for the evaluation of
the signal-to-noise ratio as defined by European Pharmacopeia. See
also “Sequencing with Blank Reference Samples” on page 89.

7 Confirm the settings to assemble the list of data files into a result set
in the specified folder.
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Sequence Log File

A sequence log file is produced that indicates what has happened during
the running of the sequence. It is useful for identifying when errors
occurred if the sequence is running unattended or overnight. The name of
the logbook file always has the .log extension. The logbook file is located
in the directory where the data of the sequence is stored.
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What Happens When a Sequence is Run?

Starting a Sequence Using Unique Folder Creation ON

The system creates a result set based on the path definition in the
sequence parameters and the sequence preference settings. The sequence
template *.s, all methods defined in the sequence table belonging to this
particular sequence are copied to the result set. If you use Intelligent
Reporting, all report templates *.rdl that are defined in the method or in
the sequence template are also copied to the result set. The system
continues to work with these files during acquisition. Starting the
sequence, the method of the corresponding sequence line is loaded within
ChemStation from this result set.

Starting a Sequence Using Unique Folder Creation OFF

Starting a sequence, the system is loading the sequence *.s file and based,
on the entry in the sequence table the corresponding method of the
sequence line is loaded within ChemStation. In contrast to the second
data storage mode Unique Folder Creation ON, no result set is created.
Sequence and methods will remain in their master directory.
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Further Executed Steps During Sequence Execution:

The following steps will be repeated for each executed sequence line:

If equipped with an autosampler, the ChemStation software first locates
the sample in the autosampler according to the number entered in the
vial column

The instrument is loaded with the method parameters.
The pre-run macro is executed.

The sample is then injected into the instrument (manually or
automatically).

The data is acquired.

The method data evaluation is done. Integration, quantification, and
reporting, including any user specified macro. If mode Unique Folder
Creation ON is used, the system stores an additional methods DA.M
during the run.

The post-run macro is executed.

During the entire process, ChemStation tracks the sequence’s progress
in real time and produces a sequence log file.

ChemStation status

Post-run macro Injection

Data evaluation

Injection and
instrument run

k,_Status
Pre-run macro { levels
—>
Load method
Raw data file
Start sequence closed
o | BN

Figure 20  Sequence Status
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Sequence Data File Structure

Preferences - Sequence Tab

On the Sequence tab in online sessions, the user has the choice of two
different data storage models. These modes define how the sequence data

are stored in ChemStation.

Preferences

ighal/Review options | Audit Trail

(%) Unigue folder creation OM

Creates a unique data falder for each sequence run. See Help for more details.

() Unigue folder creation OFF

Stores data as in ChemStation B.01.03 or earlier. This mode does nat take advantage of the latest
data reviews and reprocessing functionality in ChemStation.

Mame pattern
<HBeql> <Dater <Time: [:]
SIMO7 2010-10-03 13-69-29

(x]

I ag H Cancel H Help

Figure 21  Preferences Dialog / Sequence Tab

Switching Unique Folder Creation on or off only affects future acquisitions, but does not

change the data organization of already acquired data.

We strongly recommend to decide between the two modes at the beginning of your work

and not to switch between them.

Switching Unique Folder Creation off is not supported if your ChemStation is connected to a

central data storage system.
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Unique Folder Creation ON

In this mode of data storage, there is a robust and permanent link
between the raw data and the method. Each data file, whether acquired
within a sequence or as a single run, has a link to the method that was
used for data analysis.

The sequence data are stored in a result set using a unique result set
name. You can specify the naming conventions (Name Pattern) for these
result sets in the Sequence tab of the Preferences dialog box. If no name
pattern is specified, a default sequence name pattern is used. The
Sequence Tab is used only for data acquisition and therefore is present
only for online systems.

The sequence name pattern can contain various sections. The system
creates a name for your result set that is determined by the sequence
name pattern sections you select. All data files, methods, the sequence
logbook, the <sequence_name>.s file and the <sequence_name>.b file
belonging to this particular sequence are stored in the result set. The
result set is created when the sequence is started.

The sequence (*.s) files are used as sequence templates, and this concept
allows you to run any sequence file multiple times without overwriting
existing data or changing the sequence parameters. If neither counter nor
time is used in the sequence name pattern, the system introduces a
counter automatically to avoid overwriting data. For the second, third and
all subsequent sequences using the same sequence template, a counter is
added to the result set name.

Unique Folder Creation OFF

In this mode of data storage, the method name is the only link that exists
between the data file and the method that was used to acquire and
process it. No copies of the method are saved with the sequence or with
the data file; if the method is changed, or a new method with that name
is created, then the sequence cannot be exactly reproduced. The sequence
data files are stored in accordance with the parameters specified in the
Data File group of the Sequence Parameters dialog box; the sequence naming
facility in the Sequence tab of the Preferences dialog box is disabled in this
mode. This mode of data storage is identical to ChemStation revisions
prior to B.02.01 and therefore cannot take full advantage of the latest
Data reviewing/reprocessing functionalities in the Data Analysis view of
ChemStation.
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Sequence data acquired using the option Unique folder Creation OFF need to be
reprocessed using the reprocess option in the Method and Run Control view.

If you use ChemStation with central data storage, the preference mode Unique Folder
Creation must be ON. With central data storage, the option Unique Folder Creation OFF is
disabled.

Selecting Unique Folder Creation Off has the following impact on data storage:

* Sequence data is not acquired into a result set, but directly into the
subdirectory as specified in the Sequence Parameters (see “Sequence
Parameters” on page 75). Therefore, the sequence name pattern is
grayed out on the Sequence tab of the Preferences dialog.

* This means that for two or more sequence acquisitions the data may be
acquired into the same subdirectory.

* No sequence methods (M) or copies of the sequence file (.S) are stored
with the data, but only the sequence logfile and the batch file (.B). This
means only the methods and sequences in the paths specified in the
Preferences dialog (see “Path Selection” on page 64) are available. They
have to be used for acquisition as well as for data review and
reprocessing. Sequence or data file specific method changes can only be
stored by saving the method with different name. Otherwise these
changes are also applied to the acquisition method.

* When a sequence acquired with Unique Folder Creation Off is loaded
into the Navigation Table, the reprocessing mode in the Data Analysis
view is not available (Figure 22 on page 104). Sequences that have been
acquired with Unique Folder Creation Off can only be reprocessed in
Method and Run Control view using the Reprocessing only option in the
Sequence Parameters (Figure 23 on page 104).
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Sequence Data File Structure
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Figure 23

Reprocessing of sequence data acquired with Unique Folder Creation off
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Data File Structure With Unique Folder Creation ON

There is a strong link between the raw data, the method, and the result
set, as shown in the figures below.

Ll Chem32
- 1
- Data
Demo
- Subdirectoryll
4 Sequence(1 2013-12-06
001-010L.D
002-020L.D
003-030L.D
ATRLAL.M
qei
Methods
Sequence
TEMP
CORE
DATA_ARCHIVE
REPSTYLE

m

Marne

001-0101.D
002-0201.D
003-0301.D
ATRIALM
@ Methods Reg
|| sequence.acaml
L | SequencelLB
| SequencelLLOG
L | SequencelLs
|| Short_ESTD.rdl

Instrument number
Default data location
Result set

Method used in the sequence

Location and name of
master methods

ACAML file for
Intelligent Reporting
Batch file

Sequence log

Sequence template

Report template for
Intelligent Reporting

Master methods
Sequence templates

Report templates

Figure 24  Sequence Data File Structure “Unique Folder Creation ON”

The result set must always contain the complete set of all data files (*.D). If you delete part
of the data files, uploading the result set to central data storage will cause problems. If you
need to shorten a sequence, create a self-assembled result set from the reduced set of
sequence lines (see “Creating a Self-Assembled Result Set” on page 96).
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Figure 25 Data file content
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Data File Naming in a Sequence

Data file naming in a sequence can be done in the following ways:

* automatic,
* manual, or

* prefix/counter.
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Automatic Data File Naming in a Sequence

Sample Vials
For example 017-0103.D

where:
* The first three digits are the vial number, for example, 017.

* The fourth digit in liquid chromatography and capillary electrophoresis
is a separation hyphen (-); in a gas chromatograph, this will be either
(F) for front or (B) for back.

* The fifth and sixth digits are the sequence line that defines the method
used, for example, 01 for the first sequence line.

* The seventh and eighth digits are the injection number for this vial by
the method, for example, 03 for the third injection.

Blank Runs
For example NV--0499.D

where:
* NV stands for no vial.

* - is a separation hyphen.

.+ 0499 is the 99" blank run of sequence line 4.

Entering Data File Names Manually

One of the columns in the sequence table is named Datafile. When it
contains no entry, the data file naming scheme specified in the Sequence
Parameters (automatic or prefix- counter) is used to create the data file
name. If any text is entered into the Datafile column, ChemStation uses
that text as the data file name for the run.

If more than one injection per vial is specified on a line with a manual
data file name, ChemStation automatically truncates characters from the
end of the name entered by the user and appends the injection number.
This prevents the same data file name from being reused for multiple
injections.

ChemStation Concepts and Workflows 107



4

108

Automation/Sequences

Using a Prefix/Counter to Name Data Files

If you use the Prefix/Counter to name data files, ChemStation generates a
name for each analysis. For an instrument that supports dual signal
analysis such as the GC, ChemStation will generate a name for each
signal.

The sequence set up allows long filenames for the prefix/counter. The data
file name defined by prefix/counter can have up to fifteen characters plus
.d extension, so in total seventeen characters.

Following rules apply to the prefix/counter field:

* the counter itself can have a maximum up to 6 characters

+ if a prefix provides less than nine characters for prefix, the counter is
automatically extended to 6 digits

* the number given in the counter is the start number being incremented

Table8 File names

Prefix Counter Results in file name

long 000001 long000001

longname 000001 longname000001

testwithalongna 1 testwithalongnal
Result Set Migration

ChemStation provides a tool to migrate non-result set data to result set
format. To successfully perform this task, it is required that the original
sequence file is still available. It must contain all the necessary sequence
lines and follow the original data file naming scheme to reprocess all the
data files of the sequence. In addition, all the methods in the Method
column of the sequence table have to be available.

To perform migration, start the Result Set Migration from the Sequence menu
in Data Analysis view.
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# | Result Set Migration @

To migrate data to a result set, select sequence template, method path, data source and destination directaries

’ @Selectﬁequence Template ]

’ [0  Select Method Path l

’ =] Select Source ]

I =] Select Destination ]

Meszages and warnings: JL

Start ] I Clase ] ’ Help

Figure 26  Result Set Migration

Fill in the following required fields:

Select Sequence Template: Select the sequence file (*.S) that contains the
sequence table that matches the data set to be migrated.

Select Method Path: Select the directory where the methods are located that
are referenced in the sequence table.

Select Source: Select the directory that contains the data files to be
migrated.

Select Destination: Specify the path and name of the result set to be created.
You may select an existing folder or create a new one.
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When all fields are filled in, the migration can be started.
The following steps will be performed:
* The result set directory will be created.

* The sequence template will be copied to the result set. It will also be
converted to a state where it is able to reprocess data files in Data
Analysis view.

* The methods referenced in the sequence table are copied from the
specified method path to the result set folder.

* The data files, the sequence logbook, and the batch file are copied from
the data source directory to the destination directory.

* According to the information in the sequence table, a copy of the
corresponding method is copied to each data file as DA.M.

When the result set migration is completed, a success message is displayed
in the Messages and warnings field. Otherwise a warning message indicates
any problem during migration. Details about the warning can be obtained
by double-clicking the warning message.
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Postsequence Operation

You can specify what happens after a sequence has finished during normal
execution or when ChemStation encounters an error during sequence
operation. For LC operation, this is done by activating the post-sequence
Cmd/Macro check box of the Sequence Parameters where you have a
choice of:

+ Setting the system to a STANDBY state where the pump and lamp are
off,

* setting the system to a LAMPOFF state where all lamps are off (LC and
CE only),

* Setting the system to a PUMPOFF state where all pumps are off (LC
and CE only), or

* Using a default SHUTDOWN macro or modifying SHUTDOWN.MAC to
determine specific operation.

For example, you may want to switch off your system after your
sequence has completed. Other uses of the shutdown macro could be to
set your flow to zero or slowly reduce your flow.

In the Sequence Parameters, you may specify any custom macro to run by
including its name in the Post-Sequence Cmd/Macro field and checking
the box.

Not Ready Timeout (LC and CE only)

The Not Ready Timeout in the Sequence Parameters is the length of time
the system will wait for the instrument to become ready — after this time
the system will shut down.

Wait Time (LC and CE only)

Sequence Parameters allows you to specify a wait time which is executed
after loading method and before injecting with that method. This can be
useful for column/capillary re-equilibration when using new analysis
conditions.
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Automatic Recalibration

112

Calibration is often done after a change in operating conditions, for
example, after changing a column or capillary. Automatic recalibration is
usually done at the start of a sequence of analyses or at regular intervals
during a sequence as part of a program to compensate for factors that
affect the analytical performance.

There are two ways to specify automatic sequence recalibration:
* explicit calibration sequences, or

* cyclic calibration sequences.

Recalibration Using Preference Mode “Unique Folder Creation ON”

While performing a recalibration, the calibration table of the used method
is update according the defined method settings. Using the data storage
mode “Unique Folder Creation ON”, the recalibrated methods are available
within the result set. The calibration table of the sequence method is
updated during that process. In addition the DA.M method of the
individual data files contains the updated calibration used for result
creation.

Recalibration Using Preference Mode “Unique Folder Creation OFF”

While performing a recalibration, the calibration table of the used method
is update according the defined method settings. Using the data storage
mode “Unique Folder Creation OFF”, the calibration table of the master
method is updated during the recalibration.
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The recalibration parameters for the sequence are entered directly into the
sequence table. These parameters define how the method is recalibrated

during a sequence.

Recalibration Parameters in the Sequence Table

The response factor and retention/migration times can be updated in
several ways. The calibration level, update response factor and update
retention/migration times are instructions used in the data analysis when

recalibrating the calibration table.

When Calibration is entered in the SampleType column of the sample
table, the following columns become active and can be edited:

* Cal Level
* Update RT
* Update RF

* Interval

The values that can be entered into each of these columns are shown in

the table.

Table9  Recalibration Parameters in Sequence Table

CAL Level Update RT Update RF Interval
Calibration table Level ~No update No update Cyclic recalibration
# (1-999) interval # (1-999)
Average Average Blank
Replace Replace
Bracket
Delta%

The table shows the columns in the sequence table that contain the
recalibration parameters and the values that can be entered.

ChemStation Concepts and Workflows

113



4

114

Automation/Sequences

No Update

Does not change the response factor or retention/migration time.

Replace

Replaces the previous retention/migration times and the response (areas
or heights) with those from the current run only. The response is not
changed for any peak that is not found in this recalibration run.

Average

Averages the retention/migration times and responses (areas or heights)
for each peak based on the original calibration run and all averaged
recalibrations since then. If a peak is missing in one of the recalibrations,
the average response of the peak will not suffer.

Bracket

The samples are bracketed by pre-sample and post-sample calibrations.
Evaluation is done when the last calibration sample of the closing bracket
has been run. The existing calibration data is replaced by the result data
of the calibration run of the opening bracket. The closing bracket
calibrations are averaged to that calibration table.

Interval

The Interval determines how often a calibration is done during a
sequence. Calibration frequency corresponds to the number of sample
injections that are done before the next set of calibration injections takes
place. At the start of the analysis, a calibration is done and the results
(response factors) are entered into the calibration table. These results are
then used in subsequent quantitative calculations. After the specified
number of injections have been done, another calibration is made and the
results are entered into the calibration table overwriting the results of the
previous calibration run.
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Delta%

The delta% calculation allows you to compare response factors from an
analysis with response factors entered manually into a calibration table.
The delta% is then applied to all of the calibrated peaks in the table. You
can identify several internal standards, and their measured response
factors are then used to calculate new response factors for the other
peaks. You identify which internal standard is to be used for the delta%
calculation for each peak in the calibration table.
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Types of Sequences
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When preparing a sequence, you can use the following types of sequences:
* explicit calibration sequences,

* explicit single-level calibration sequences,

* cyclic multiple-level calibration sequences,

* explicit and cyclic calibrations together in a sequence, and

* cyclic calibration sequences with bracketed calibrations.

After submitting the sequence to the Run Queue, all sequences (including sequences with
bracketed calibrations) are transformed to explicit calibration sequences. See “Running a
Sequence” on page 90.

During the run, the sequence table simply shows the injections, run by run, as they are
processed by the instrument. If you add a sample during the run, all subsequent samples
(including calibration samples) will move downwards in the sequence table.

Explicit Calibration Sequences

This type of sequence recalibrates at defined intervals specified by you in
the sequence table.

For explicit calibration sequences, the calibration samples are entered in
the sequence without an interval entry in the sequence table. A
recalibration is done once for each calibration sample entry in the
sequence table.
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Cyclic Single-Level Calibration Sequences

This type of sequence uses the same vial, that is, the calibration sample at
regular intervals in the sequence.

The interval entry in the sequence table determines how the recalibration
is done. For example, an interval value of 2 will recalibrate after every
two sample vials in the sequence.

Cyclic Multiple-Level Calibration Sequences

This type of sequence uses different calibration samples to recalibrate a
multiple-level calibrated method.

The following example describes a two-method sequence comprising
method A and method B to analyze two groups of samples. Both methods
are multiple-level calibration methods that will recalibrate automatically at
defined intervals.
For each method the Sequence Table has three entries:
* Two calibration levels:

Sequence lines 1 and 2 in method A.

Sequence lines 8 and 9 in method B.
* Five entries for the samples:

Sequence line 3 through 7 in method A.

Sequence line 10 through 14 for method B.
The calibrations are specified at regular intervals by the recalibration
interval entry in the Sequence Recalibration Table.
* Method A will recalibrate after every two samples.

* Method B will recalibrate after every three samples.

The Sequence Table below is truncated to simplify the example.
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Table 10 Sequence Table for Method A and Method B

Line Sample Method Name Inj/Loc  Sample Type Cal Update RF Update RT Cal
Location Level Interval
1 1 Method A 1 Calibration 1 Average No update 2
2 Method A 1 Calibration 2 Average No update 2
3 10 Method A 1
4 1 Method A 1
5 12 Method A 1
6 13 Method A 1
7 14 Method A 1
8 3 Method B 1 Calibration 1 Average No update 3
9 5 Method B 2 Calibration 2 Average No update 3
10 20 Method B 1
" 21 Method B 1
12 22 Method B 1
13 23 Method B 1
14 24 Method B 1
Method A Analysis Order
Method A is the first part of the two-method sequence.
Table 11 Method A Analysis Order
Inj No. Method Vial Operation
1 Method A 1 Calibration level 1 and report
2 Method A 2 Calibration level 2 and report
3 Method A 10 Sample analysis and report
4 Method A 1" Sample analysis and report
5 Method A 1 Calibration level 1 and report
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Table 11  Method A Analysis Order

Inj No. Method Vial Operation

6 Method A 2 Calibration level 2 and report
7 Method A 12 Sample analysis and report
8 Method A 13 Sample analysis and report
9 Method A 1 Calibration level 1 and report
10 Method A 2 Calibration level 2 and report
1" Method A 14 Sample analysis and report

Method B Analysis Order

Method B is the second part of the two-method sequence. Method B
differs from Method A in that there are two injections per vial for
calibration level 2. The Interval entry is set to 3.

Table 12 Method B Analysis Order

Inj No. Method Vial Operation

12 Method B 3 Calibration level 1 and report
13 Method B 5 Calibration level 2 and report
14 Method B 5 Calibration level 2 and report
15 Method B 20 Sample analysis and report
16 Method B 21 Sample analysis and report
17 Method B 22 Sample analysis and report
18 Method B 3 Calibration level 1 and report
19 Method B 5 Calibration level 2 and report
20 Method B 5 Calibration level 2 and report
21 Method B 23 Sample analysis and report
22 Method B 24 Sample analysis and report
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Note that the results shown in Table 11 on page 118and Table 12 on
page 119can be obtained by using Partial Sequence to see a preview of the
run order after setting up the Sequence Table.

Explicit and Cyclic Calibrations Together

This type of sequence comprises explicit and cyclic calibrations in the
same sequence.

This feature allows you to recalibrate the method completely at the
beginning of a sequence (explicit recalibration) and then update the
calibration (cyclic recalibration) during the sequence.

* Two calibration lines for each calibration level in the Sequence table
must be specified. One calibration line is for the explicit recalibration
entry and the other for the cyclic recalibration entry.

* The sequence table must have entries for each calibration line and all
cyclic recalibration vials must appear before both the explicit
recalibration and sample entries.

Example

The sequence table below illustrates a single-level calibrated method called
SimpReg. It is truncated to simplify the example.

Table 13  Sequence Table for SIMPREG

Line Sample Method Name Inj/Loc  Sample Type Cal Update RF Update RT Cal
Location Level Interval

1 1 SimpReg 1 Calibration 1 Average Average 3

2 1 SimpReg 1 Calibration 1 Replace Replace

3 2 SimpReg 1

4 3 SimpReg 1

5 4 SimpReg 1
5 SimpReg 1

7 6 SimpReg 1
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There are two entries for the single calibration level.

* The first calibration line is for the same level but averages the
calibration parameters. The interval entry specifies that the
recalibration is done after every three samples.

* The second entry replaces all the recalibration parameters, that is, a
complete recalibration is done. It has no recalibration interval.

Sequence Table The sequence table comprises seven lines. The first line specifies the cyclic
recalibration sample. The second line specifies the explicit recalibration
that is done only once at the beginning of the sequence. The third through
seventh lines specify the samples to be analyzed.

The order of the entries into the sequence table is very important. All
cyclic recalibration vial entries specifying cyclic calibration must appear
before the sample entries or any explicit recalibration entries for the
method.

SimpReg Analysis Order

The table below describes the analysis order for the SimpReg method.

Table 14  SimpReg Analysis Order

Seq Line Inj No. Method Vial Operation

2 1 SimpReg 1 Simple calibration
1 2 SimpReg 1 Regular calibration
3 3 SimpReg 2 Sample analysis

3 4 SimpReg 3 Sample analysis

4 5 SimpReg 4 Sample analysis

5 6 SimpReg 1 Regular calibration
6 7 SimpReg 5 Sample analysis

7 8 SimpReg 6 Sample analysis
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Cyclic Calibration Sequences with Bracketing

In a cyclic calibrated sequence with bracketing, the calibration table used
to calculate the unknown quantitative results is generated by averaging the
results of the current calibration with those of the previous calibration.
This new calibration table is a more accurate representation of the
instrument response at the time the sample was analyzed.

Example

Consider the following situation:
* The instrument response is drifting.
* Three injections of an identical two-component mixture are specified.

* Two injections are specified as calibration samples, and one is specified
as a sample.

* The first and third are calibration samples.
* The second injection is a sample.
To obtain a precise quantitative result for injection two (the sample), an

interpolation must be made between the two calibration samples; see the
figure. This process is known as bracketing.

Time
In§trument . >
drift i o

HEHE!

Calibration 1 | Sample Calibration 2

Figure 27  Bracketing

122 ChemStation Concepts and Workflows



Automation/Sequences 4

Bracketed Sequence Operation

* The first calibration vials are analyzed.
* The sample vials are analyzed.
* The next calibration vials are analyzed.

* The calibration table is produced by replacing the existing response
factors by new ones and averaging the following calibration runs into a
new calibration table.

* The sample vial data files are evaluated, and reports are generated.

* The sequence returns to step 2 if there are more sample vials to be
analyzed.

Example

This section describes a sequence bracketing example comprising one
method called Brack.M. The Brack.M method is a two-level internal
standard method using cyclic calibration.

Sequence Table The sequence table of Brack.M (next page) is truncated to simplify the
example. It consists of seven lines. The first two lines define the
recalibration conditions for each level. The remaining lines define the
samples to be analyzed.

More specifically, the sequence table of Brack.M method has:

* A Bracket entry in the Update Response Factor column that specifies
bracketing of samples with calibration samples.

* A Replace entry in the Update Retention/Migration Times column which
specifies a replacement of the retention/migration times.

* An entry of 3 in the Recalib Interval column that specifies recalibration
after every three samples.
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Line Sample Method Name Sample Type Cal Update RF Update RT Cal
Location Level Interval

1 1 BRACK-M Calibration 1 Bracket Replace 3
2 BRACK-M Calibration 2 Bracket Replace 3

3 10 BRACK-M

4 11 BRACK-M

5 12 BRACK-M

6 13 BRACK-M

7 14 BRACK-M
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Cyclic Recalibration Sequences with Multiple Vials Containing the
Same Dilution of a Standard

Cyclic Recalibration Sequence with “Round-Robin” Calibration Vial
Usage

When running a large sequence that performs cyclic recalibrations, that is,
performs an automatic recalibration after a fixed number of sample
injections, there is a potential risk of emptying the volume of calibration
vial during the course of the sequence. The ChemStation sequence table
provides a means of using a series of vials that contain the same dilution
of a standard to be used in a round-robin fashion.

With this capability, large sequences can be defined with automatic
recalibrations at fixed intervals using multiple calibration vials for each
level and each calibration vial would be consumed to the same extent.

By defining an appropriate number of calibration vials, it is even possible
to guarantee that each calibration vial is only used once. This is an
important requirement in cases where a fresh calibration vial is required
for every recalibration, for example, because the analyte evaporates once
the septum is punctured or starts degrading after getting in contact with
the steel needle. The following section describes how the ChemStation
sequence table needs to be set up to fulfill these requirements.

Determine the total number of calibration vials for each level based on the
estimated calibrant usage throughout the sequence.

Set up a separate cyclic recalibration line for each calibration vial. Lines
defined for the same calibration level must be in adjacent sequence lines
and the defined vial positions must be adjacent, too. Choose an identical
recalibration interval for all calibration lines. For example, if your
sequence should recalibrate after every 6 sample injections, set the
recalibration interval to 6.
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Vial No. Sample Name Sample Type Method Name No. of Inj. Lvi UpdRT UpdRF Interval
1 Calla Calib MethodA 1 1 Avg Avg 6
2 Callb Calib MethodA 1 1 Avg Avg 6
3 Callc Calib MethodA 1 1 Avg Avg 6
5 Cal2a Calib MethodA 1 2 Avg Avg 6
6 Cal2b Calib MethodA 1 2 Avg Avg 6
7 Cal2c Calib MethodA 1 2 Avg Avg 6
10 Sample10 Sample MethodA 6
" Samplel1 Sample MethodA 6
12 Samplel12 Sample MethodA 6
13 Sample13 Sample MethodA 6
14 Sample14 Sample MethodA 6

The execution order is:

* Vial 1 (Calla)

* Vial 5 (Cal2a)

* 6 injections out of vial 10 (Samplel0)

* Vial 2 (Callb)

* Via 6 (Cal2b)

* 6 injections out of vial 11 (Samplell)

* Vial 3 (Callc)

» Vial 7 (Cal2c)

* 6 injections out of vial 12 (Samplel2)

* Vial 1 (Calla)

* Vial 5 (Cal2a)

* 6 injections out of vial 13 (Samplel3)

* Vial 2 (Callb)

* Vial 6 (Cal2b)

* etc.
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Cyclic Recalibrations Where Each Calibration Uses a Different Vial

To ensure that every calibration vial be injected only once, the sequence
must define a sufficient number of different calibration vials, so that the
round-robin order described in the previous example is not applied. For
example, if the sequence processes 80 sample vials with recalibrations
required after every 10 samples, the sequence table must contain

80/10 + 1= 9 calibration lines for each level.

As in the previous example, the calibration lines must be adjacent
sequence lines that reference adjacent vial positions.

Bracketing Sequence that Uses Different Vials for Opening and Closing
Bracket

The same capability is available for bracketing sequences. By defining the
appropriate vial range of calibration vials, a bracketing sequence can be
defined so that different calibration vials are used for the opening and
closing brackets. In this case, too, calibration lines in the sequence must
be adjacent just like the vial positions of the calibration vials.

Whether or not the bracketing calibration vials are used in round-robin
mode or for one single injection only simply depends on the total number
of calibration vials for each level and the number of recalibrations
required by the sequence.

The following example defines 3 sample injections that are bracketed by
calibrations. The opening bracket uses a different calibration vial than the
closing bracket. Recalibrations are required after every sample injection. so
the recalibration interval has to be 1. The number of calibration lines per
level is the number of samples plus one.
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Table 17 Different Vials Used for Opening and Closing Brackets

Vial No.  Sample Name Sample Type Method Name No.ofIlnj. Lvli UpdRT UpdRF Interval

1 Calla Calib MethodA 1 1 Brkt Brkt 1
2 Callb Calib MethodA 1 1 Brkt Brkt 1
3 Callc Calib MethodA 1 1 Brkt Brkt 1
4 Calld Calib MethodA 1 1 Brkt Brkt 1
10 Sample10 Sample MethodA 1
" Samplel1 Sample MethodA 1
12 Samplel12 Sample MethodA 1

The execution order for this sequence is:

* Vial 1 (Calla), Opening Bracket 1

» Vial 10 (Samplel0)

* Vial 2 (Callb), Closing Bracket 1 and Opening Bracket 2
* Vial 11 (Samplell)

» Vial 3 (Callc), Closing Bracket 2 and Opening Bracket 3
* Vial 12 (Sample 12)

* Vial 4 (Calld), Closing Bracket 3
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This chapter explains the concepts of Run Queue and Queue Planner. It
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Using the Queue Planner 137

explains how to add single samples, sequences, or pauses to the Run Queue.
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Supported Workflows

The Run Queue controls all runs in ChemStation:

Whenever you use the RunControl > Run Method or RunControl > Run
Sequence command to run a method or a sequence, the item is first
added to the Run Queue and is then automatically started from there.
If the Run Queue is currently paused, the item will be added to the
front of the queue, followed by a queueable pause. That way, the
instrument will return to the paused status when the run has been
finished.

The Run Queue also allows you to schedule a series of samples and
sequences along with additional parameters. You can add samples or
sequences to the queue with the RunControl > Queue Method... or RunControl
> Queue Sequence... command. With the Run Queue, you can automate
lengthy operations such as overnight or weekend jobs. In addition to the
samples and sequences, you can also schedule pauses. In these pauses,
ChemStation shows a customizable message and waits for a user
confirmation.

With the Queue Planner, you can prepare Queue Plans in advance and add
them to the Run Queue at a later point in time.

The following workflows are supported:

132

Run a single sample
Run a single sequence
Queue a singe sample
Queue a single sequence

a Select a classic ChemStation sequence template or an Easy Sequence
template

b Edit or review the sequence table

¢ Edit or review the sequence parameters
d Save the settings

e Add the sequence to the queue
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* Change the Run Queue

* Prepare a Queue Plan

* Add a predefined set of sequences to the Run Queue
a Select a Queue Plan
b Add the plan to the Run Queue

In the History Queue, you can always see which runs have been executed
on the current instrument.

Run Queue and Queue Planner are only available in online ChemStation
sessions in the Method and Run Control view.
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Using the Run Queue

134

The Run Queue is both in the Instrument Control tab or in the Run Queue tab.
In the Instrument Control tab, you can show or hide the Run Queue with
the View > Run Queue command.

oy
== Run Queue

Active Queue: Data System Accepting Sequences =

Sequences in the Active Queue: 7 |® |@ @ | x (j | % |[% | @ |@‘

'Name Time entered into Queus | Estimated Completion Ti... | Status
Pause the queus 3/20{2012 §:49:50 PM Pending
samplz2 3/20{2012 §:53:03 PM Pending
sample3 3/20/2012 §:55:31 PM Pending
Pause the queue 3202012 6:52:39 FM Pending
sampled SIENZ01Z 6:55:40 FM Pending )
samples S/F0f2012 8:55:58 PM Pending

Figure 29  Run Queue dialog

You can add an item to the front or to the back of the queue. As long as
the status of the items in the queue is pending, you can change both the
execution order and the properties of the item. Depending on the Active
Queue Options, the first item in the queue either starts when the data
system is ready or when you resume the queue.

The Run Queue supports single samples, Easy Sequence templates, and
classic ChemStation sequences. The only items that cannot be added to
the Run Queue are Partial Sequences, Priority Samples, and Runs that are
started directly from the instrument.

For more information on Easy Sequence, see the online help system. Easy
Sequence Setup tutorials are available in online help.
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Single Samples in the Run Queue

To add a single sample to the queue, use the menu RunControl > Queue
Method.... You can modify all parameters in the Queue Method dialog.

Sequences in the Run Queue

To add a sequence to the queue, use the menu RunControl > Queue
Sequence.... You can modify the sequence table and sequence parameters
without changing the currently loaded sequence. Before finally queuing the
sequence, a dialog offers you to either add the sequence to the queue or
to save it as a new sequence template.

The Finish Queue Sequence dialog also contains the check box Delete temporary
Sequence Template after completion. ChemStation always keeps a copy of the
queued sequence template in a temporary directory. This temporary
sequence template will be used to run the sequence from the queue. As
the same sequence may be queued several times using different
parameters, ChemStation needs a separate copy for each queued item.

Depending on the status of the check box, this temporary sequence
template will be kept or deleted when the queue continues with the next
item. The check box may be selected or cleared by default, depending on
the settings for Unique Folder Creation (see “Preferences - Sequence Tab” on
page 101):

* With Unique Folder Creation OFF:

The Delete temporary Sequence Template after completion check box is cleared
by default.

If you want to reprocess the data, you will need the sequence template,
therefore we recommend to keep a copy of this file. By default, it is
saved under Chem32\<instrument>\SEQUENCE.

+  With Unique Folder Creation ON:

The Delete temporary Sequence Template after completion check box is selected
by default.

All information required for reprocessing is already available in the
result set, therefore you do not need a copy of the temporary sequence
template. However, if you select the check box, a copy is saved by
default under Chem32\<instrument>\TEMP\AESEQ.
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Pauses in the Run Queue
To schedule a pause to the queue, click Add Pause to Queue in the Run

Queue toolbar. In these pauses, ChemStation shows a customizable
message and waits for a user confirmation.
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Using the Queue Planner

Using the Queue Planner

With the Queue Planner, you can prepare an ordered set of sequences
(Easy Sequence template *.es or classic ChemStation sequence templates
*.s), or pauses. The entire Queue Plan can be added either to the back or
to the front of the Run Queue.

The queue plan is saved as a *.qpl file. You open the Queue Planner in the
Method and Run Control view via the menu RunControl > Queue Planner....

ue Planner: GC7B%0, C:AChem 32¥1\sequencelplani. gpl

| Action Details Delete  Data Directory EEETE"EE Remate Data Path Smaren H

. un Classic Sequence | def_ge.s CAChem32\T\DATAN use preferences H
2 5 Run Classic Sequence  LOADTEST.S CAChem3zy I \DATAY O use preferences

3 Confimtocontinue | [ n/a O néa a
4 LOADTEST.S CAChem324TADATAY .| use preferences

[a‘ Add to front of queus

[ Cancel H Heln l

é Save .. % Save Az, l [e‘ Add to back of queue

Figure 30  Queue Planner

As in the Run Queue, when you add a pause, you can provide your own
message in the Details column. When the Sequence Queue reaches the
pause, ChemStation stops, and displays the given message. A user must
confirm the message before the queue can continue.

For more information on the user interface, see the online help system.
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This chapter outlines the data analysis and data review options. In OpenLAB
CDS ChemStation Edition, these options are available in two separate views.
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Data Analysis

Once the data has been acquired, it can be analyzed in ChemStation Data
Analysis view. When selecting the Data tab of the ChemStation Explorer,
you can load all the runs of a sequence or all single runs in a specific
folder by double-clicking the corresponding symbol. The corresponding
data set is then available in the Navigation Table.

.E! Local LC Sim {online): Data Analysis
File  Method Sequence Recalculate Graphics [ntegration Calibration  Report  Spectra  Batch  Wiew Abort Help

Signals L_Mz L@ ‘ hethods l_a qﬁ W m LC_DEMO.M [sequence] | J}

[ CYTHEMSZYLDATA
=3 DEMO

& BATCH

& LC_DEMO1

@ Single Runs

- ESTD_DAD

(£ 15T0_DAD

140

- FRACTION_COLLEC...

(£ OTHER_LC_DETECT..,

Sequence: LC A0
== ==l E| T
B 288 3IBEA S0 zl@
Overlay Type Line Inj vial Sample Name Acq. Method Sample Type Sequence Method
- @ 1 1 P1-F-01 isocratic sample... LC_DEMO.M Calibration LC_DEMOM
1 -] 2 1| P1-F-02 isocratic sample STD | LC_DEMO,M Calibration LC_DEMOLM
+H [ -] 3 1| PL-F-03 isocratic sample STD |LC_DEMO,M Calbration LC_DEMO.M
[0 -] 4 1| P1-F-04 isocratic sample 1 LC_DEMO.M Sample LC_DEMO.M
] [ =] 5 1| PL-F-05 isocratic sample €5 |LC_DEMO,M Sample LC_DEMO.M
[0 -] 3] 1| P1-F-06 isocratic sample 2 |LC_DEMO.M Sample LC_DEMO.M
1 =] 7 1/ P1-F-05 isocratic sample ©5 | LC_DEMO.M Sample LC_DEMOLM
4 | il |
Elntegratiun 5} Calilration MSigna\ uﬂMPunfy %Spedrum

Figure 31 Loading a sequence from the ChemStation Explorer into the Navigation Table

The main body of the Navigation Table consists of a list of all runs of the
set. You can load a run into ChemStation memory by double- clicking the
relevant line in the Navigation Table. Additionally, right-clicking on a run
offers several options, for example, to load or overlay specific signals from
the file, to export the data, or to view the acquisition method parameters.

Sequence runs are (in the Reprocessing mode) loaded with the sequence
method that has been used during acquisition or reprocessing. The name
of this method is shown in the toolbar, and also in the Sequence Method
column in the Navigation Table. The acquisition method name is shown in
the Acq Method column.
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Single runs may be loaded with one of the following methods, depending
on the settings under Preferences > Signal/Review options (see figure below):

» If the check box (1) is selected, and the single run was last analyzed or
reported with a method located in one of the currently defined master
method paths, the single run is loaded with this master method. The
method is shown in the Analysis Method column in the Navigation Table.

* If the check box (1) is cleared, single runs are loaded with the master
method that was last loaded in ChemStation.

The acquisition method name is shown in the Acq Method column.

ChemStation allows you to specify default actions that are performed
automatically when a data file is loaded from the Navigation Table. These
include data analysis tasks like integrating the chromatogram directly after
loading, or printing a report for each single injection (see figure below).

Preferences @
- Signal/Review ophions | Aydit Trail

Load signal

[ Load using signal details

Integrate after load

[] Integrate and print repart after load
Auto step interval 10 sec

Load zingle run in Recalculate Mode

Automatically lbad master method used for last data analysis

Load result get

() Stay in curent mode after load [Reprocess or Recalculate Mode)

(@ Switch to repracess mode after load

[ QK ” Cancel H Help

Figure 32  Signal/Review options tab of the Preferences dialog
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Data Analysis Modes

You can choose between the following Data Analysis modes:
* Recalculation mode
* Last Result mode

* Reprocessing mode

These modes are accessible either via the View menu or via the tool set
(see figure below).

Ba

Figure 33  Mode selection

For each of the modes, the tool set contains specific functions. The modes
and the respective functions are described in the following sections. In the
Signal/Review Options tab of the Preferences dialog box, you can choose
which mode should be active by default when you load a result set (see
Figure 32 on page 141, marker 2).

Recalculation Mode

Once the run is loaded, you can review it, that is, adjust data analysis
parameters, integrate the signals and finally print a report. In this case
you analyze the run as a single run without taking the sequence context
into account or using the features of the sequence table. The Navigation
Table for this type of data analysis provides the toolset shown in the
figure below.

@ > bl Md P

Figure 34  Recalculation toolset of the Navigation Table

With this toolset, you can jump to the beginning or end of the navigation
table, step on to the next or previous run, automatically step through the
runs, stop automatic stepping, recalculate a run using a specific method,
or clear the Navigation Table.
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Recalculation means analyzing on a run-per-run base. Only the runs
shown in the Navigation Table are analyzed. If you applied a filter to the
Navigation Table, only those runs actually shown in the table are
recalculated. The sorting of the Navigation Table is also taken into
account.

You can use recalculation in the following workflows, for example:

* You want to review the data files of a result set with a different
method that is not currently in the result set, for example, a master
method not used for acquisition, because your workflow employs
separate acquisition and data analysis methods.

* You have edited a sequence method and want to review only specific
runs using this method in order to check how well these parameters
apply for different runs.

Data Analysis Method for Single Runs

In previous releases, no method was automatically loaded along with any
data file in Recalculate mode. From release C.01.05, you can select the
check box to automatically load the master method used for the last data
analysis (see Figure 32 on page 141, marker 1). If this check box is
selected, single runs are loaded with the corresponding master method, if
the method still exists at the given location.

Recalculate With Specific Method

With this function, you can recalculate the runs shown in the Navigation
Table using a specific master method. You specify the required master
method in the Recalculate With Method dialog (see figure below). If the
selected master method uses Intelligent Reporting (see “Reporting” on
page 175), you can also specify the report template that will be used for
the single injection reports.
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Recalculate with Method PZ|
Method: | | [ Browse. .. ]
Repart template: | | [ Browse... ]

Auto step interval: FEC

Destination
(3) Preview () Printer () Az specified inmethad () Mone [ho repart]

Use referenca] |

[ ak I [ Cancel ] [ Help

Figure 35 Recalculate With Method dialog

The Browse for methods in master paths dialog and Browse for templates in master
paths dialog offer all file locations that you specified in the Preferences.

In previous revisions of ChemStation you have been able to recalculate with a specific
method by choosing Use current method, Use method from data file, or Use sequence
method in the toolbar.

If you select the Use reference check box, you can select a data file
containing a reference signal. ChemStation uses this signal to calculate the
signal-to-noise ratio as defined by European Pharmacopeia. The
drop-down list offers the data files that you used during the current
session. With the Browse button, you can select any data file that is also
present in the Navigation Table. If want to use a different reference file,
you must first add it to the Navigation Table.

The new reference overwrites the previous one and will be used from now
on in signal-to-noise calculations in every report. If you select the Use
reference check box, but do not select any file, the references are cleared
for all recalculated data files, and no signal-to-noise values will be
calculated from now on.

Each time you recalculate a sample or generate a report, the data file
method (DA.M) is automatically updated with the data analysis parameters
of the used method. The path to the specific method is saved as a
reference in the data file.
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Last Result Mode
R A

Figure 36  Last Result Mode toolset of the Navigation Table

In this mode, the data file method (DA.M) for each run is loaded. DA.M is
an exact copy of the method which was used for the last data analysis
(during acquisition, reprocessing, or recalculation). So even if the sequence
method has been changed in the meantime, you can reproduce the last
result with the method originally used. In that way you can, for example,
track changes done to the method in successive recalibration steps in a
result set.

The method name in the toolbar shows DA.M, which indicates that the
data file method is loaded. When you move the mouse pointer over this
field, a tool tip additionally displays the full path and name of the
method. In addition, the name of the method last used for data analysis
(which was copied to DA.M) is shown in the Analysis Method column in the
Navigation Table. The tool tip of this column shows the full path of this
method.

The DA.M is normally read-only. You cannot manually load it, it is only loaded by
ChemStation in the Last Result Mode for recalculation. You can edit it, but you cannot
manually save it. If you have edited and changed the method, you cannot generate a report
any more, as this would imply saving the DA.M method and thus possibly lead to
inconsistencies in the system.

In Last Result Mode, you can update the loaded master method or any
master method with the current data analysis parameters from the DA.M,
or save a changed DA.M method as an entirely new master method. For
example, you loaded a data set analyzed a few weeks or months ago, and
you find the data analysis parameters stored in the DA.M useful for your
current work. You can then transfer the settings to a master method of
your choice. For more information, refer to “Administrating Methods” on
page 48.
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Reprocessing Mode

A different way to analyze your data is to Reprocess a complete sequence.
In contrast to recalculation, all runs are reanalyzed in the sequence
context, i.e. the calibration tables of the sequence methods are updated in
the case of calibration runs, and multipliers, amounts etc. can be changed
in the sequence table.

The result set includes all files needed for reprocessing: the data files, a
copy of the sequence file, all the sequence methods and all the report
templates originally employed with the acquisition. Thus, in order to
reprocess a sequence you simply have to load it into the Navigation Table
and select the reprocessing tool set.

If it becomes necessary to propagate changes in the sequence method to
the corresponding master method as input for all future acquisition runs,
you can achieve this conveniently by using the Update Master Method
functionality (see “Updating DA Parameters in the Master Method” on
page 51).

The DA.M is automatically updated each time you reprocess a data file.
For reprocessing, the navigation table provides the following toolset:

BRR iRl SBE A6 0]

Figure 37  Sequence Reprocessing Toolset of the Navigation Table

With this toolset, you can edit the sequence table, edit the sequence
parameters, save the current sequence, print the current sequence, show
or hide the sequence logbook, view the saved sequence summary report
file(s), start sequence reprocessing, stop the sequence, or pause the
sequence.

Note that the reprocessing icons in the Navigation Table are available only
for result sets generated with ChemStation B.02.01 and higher.
Reprocessing in Data Analysis is not accessible for single run data, for data
generated prior to B.02.01, and for data acquired while Unique Folder
Creation is switched off (see “Preferences - Sequence Tab” on page 101).
Such sequences need to be reprocessed in Method and Run Control, defining
the sequence parameter Part of method to run as Reprocess Only. For sequences
generated with ChemStation B.02.01 and higher, the reprocessing option in
Method and Run Control has been removed, and the navigation table offers
reprocessing as a Data Analysis Task.

ChemStation Concepts and Workflows



Data Analysis and Review Concepts 6

Another alternative is to add such samples or sequences to a new
self-assembled result set. There you also assign sequence methods, and
you can reprocess the entire sequence afterwards (see “Self- Assembled
Result Set” on page 150).

Note the following rules with regard to reprocessing:

* When loading a result set into the Navigation Table, ChemStation also
automatically loads the sequence file (*.S) that is located in this result
set. This sequence file contains all the sequence lines that are related to
any data file belonging to this result set.

» All actions are performed on the sequence methods. If changed analysis
parameters are to be applied, you have to change the sequence
methods.

* During reprocessing, the Batch (*.b) file, the sequence/single run log
(*.log), and the Navigation Table are updated. The individual data
analysis method (DA.M) of each processed data file is overwritten with
the sequence method.

* To add new methods from one of the master method directories to the
sequence table, use the ChemStation Explorer to copy the master
method to the result set, or click Method > Update Methods.... You can
then select the new sequence method in the sequence table. It is not
possible to add or remove lines in the sequence table.

* In the Sequence Parameters dialog, only the sequence comment and the
usage of sequence table information can be changed. All other fields
have to be set during data acquisition or do not apply to reprocessing.
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Sequence Parameters: Local LC @
Sequence parameters | Sequence oulput
Path: ChChem3Zh14Datah
SYETEM
Subdirectary:
@ Auto Frefis Counter
Prefis/Counter SlE1 000001
Transfer Settings. .
Part of method ta run Shutdown
Reprocessing Only [ Post-Sequence command/macro
Use sequence table information FUMPALL OFF
Wil 0.00 “| minutes after loading a new method, Mot ready timeout: 0.00 S| minutes,
Usze in sequence On barcode mizmatch don't inject Fraction start location:
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Sequence comment:
I

o ) [ome | [ Feb ]

Figure 38 Sequence Parameters in Data Analysis

Treatment of Manual Integration Events

Manual integration events, for example, a manually drawn baseline, are
even more data file specific than timed integration events. In case of
complicated chromatograms, it is highly desirable to be able to use these
events for reprocessing.

Therefore, in ChemStation B.04.01 and higher, manual integration events
can be stored directly in the data file instead of the method. Whenever
the data file is reviewed or reprocessed, the manual events in the data file
are automatically applied. A run containing manual integration events is
marked in the Navigation Table in the corresponding column.
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In addition to the tools for drawing a baseline and deleting a peak
manually, three other tools are available in the user interface to:

* save manual events of the currently shown chromatograms into the data
file,

* remove all events from the currently shown chromatograms

* undo the last manual integration events (this is available until the event
is saved)

When continuing to the next data file during review in the Navigation
Table, ChemStation will check for unsaved manual integration events and
ask the user whether he wants to save the events.

Manual events stored in the data file during review in the Navigation
Table do not interfere with manual integration events stored during review
in the Batch mode. These two ways of review are completely separated
with regard to the manual events of a data file.

In ChemStation revisions prior to B.04.01, manual integration events could
only be stored in the method. In B.04.01, this workflow can still be used.
The Integration menu in Data Analysis view provides the following items in
order to handle manual integration events with the method:

Update Manual Events of Method: Save newly drawn manual events to the
method.

Apply Manual Events from Method: Apply the manual events currently saved in
the method to the currently loaded data file.

Remove Manual Events from Method: Delete the manual events from the
method.

In order to convert manual events stored in a method to storage in the
data file, apply the events from the method and store the results in the
data file. If required, remove the events from the method.

If the Manual Events checkbox of the Integration Events Table of a method is
selected, the manual events of the method are always applied when
loading a data file using this method. If the data file contains additional
manual events, the events in the data file are used. When the Manual Events
checkbox is selected, the user is never asked to save the events to the
data file.
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Self-Assembled Result Set

In the Data Analysis view, the Navigation Table shows the contents of the
single run or sequence that is loaded. You can load, unload, or add data
files to the Navigation Table. Using the Sequence > Create New Result Set
command, you can create a new self-assembled result set from the data
currently shown in the Navigation Table (see “To assemble a new result
set” on page 97). Self-assembled result sets can be reprocessed the same
way as automatically created result sets.

Unload Current Dataset

Using the Unload Current Dataset command from the context menu of the
Navigation Table, you can revert the Navigation Table to the original
empty state, as it is directly after launching ChemStation. If there is
unsaved data, you are asked to save it.

Delete Selected Data File

Using the Remove selected Data Files command from the context menu of the
Navigation Table, you can remove the selected lines from the Navigation
Table. This only removes the reference in the Navigation Table, it does not
delete the physical data file from the loaded result set or single run on
the file system. It is only possible to delete the references of
added/overlaid files.

Updating Methods

In the Data Analysis view, you have several options to copy methods
between the master method directories and the result sets. For more
information, refer to “Administrating Methods” on page 48.
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Report Viewer for Data Analysis

Depending on the configuration, ChemStation automatically saves the
single injection reports and sequence summary reports to the file system
at a certain point in time. With the Report Viewer, you can easily view the
saved report files in order to check the results from data acquisition,
reprocessing or recalculation.

MM Report Yiewer

| |B#30/2011 42450PM  DEMODDOOTisocratic sample STO20T1-06-30P | v M oper:

BBL e 0eEn; |

Data file: CACHEM32\I'\DATA'DEMOWC_DEMO1\DEMOO000001.D

Sample name: isocratic sample STD

Description: isooratic check out sample, calibration mixture 1

Instrument: Instrument 1 Location: P1-F-01
Injection date: T/9/2008 10:25:53 AM Injection 1of1
Acq. method: LC_DEMO.M Injection volume:  3.000
Analysis mathod: LC_DEMO M Acq. operator: AGH
Last changed: 11/16/2010 10:15:25 AM

Sample amount: 0.000 Sample type: Calibration
Muttiplier. 1 Dilution: 1

i ; Lims I0: b
===

Figure 39  Report Viewer

Using the Report Viewer has the following advantages:

* You can directly open the report files from ChemStation. You do not
need to search for the files in the file system.

* Each report opens in a separate floating window. Therefore, you can
easily compare different reports by placing the windows side by side.

* You can use the full screen to view the report file.
* You can use the features from Adobe Reader to view .pdf reports.
* You can search for specific text in .txt reports as well as .pdf reports.

* When you reprocess a sequence, you do not have to wait until the
entire sequence reprocessing is completed. You can open the saved
report files for those sequence samples that are already completed.
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Starting the Report Viewer

You can open the Report Viewer via the menu, via toolbar icons, or via
the context menu of the Navigation Table. There are different items for
sequence summary reports and single injection reports.

To view single injection reports:

+ Select the menu Report > View Report File to view the report file or files of
the loaded signal.

* Select the View Saved Report File(s) command from the context menu of a
specific sample in the Navigation Table. With this command you can to
load the report file or files of any signal, even if it is currently not
loaded.

+ Click the View saved Report File(s) icon from the Workspace Toolbar to
view the report file or files of the loaded signal.

!
8
To view sequence summary reports:
* Select the menu Sequence > View Summary Report File.

* Click the View Saved Sequence Summary Report File(s) icon from the
Navigation Toolbar (in reprocessing mode).

gk

Configuring the Report Viewer Windows

You can configure several aspects of the Report Viewer behavior. All of
these settings are accessible via the Options button in the Report Viewer
window.

You can define the maximum number of Report Viewer windows that will
be open in parallel. The windows are cyclically reused. When you view
more report files than the maximum number of Report Viewer windows,
the first opened windows are the first to change their content.

If you do not need to compare multiple reports, we recommend to limit the number of
Report Viewer windows to 1.
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For comparing multiple reports, it may also be helpful to adjust the title
bar of the Report Viewer windows. Various tokens are available for Report
Viewer windows displaying sequence summary reports, single injection
reports for sequence samples, or single injection reports for single runs.
These tokens help you to distinguish the single Report Viewer windows.

The Report Viewer windows are always displayed on top of the
ChemStation application. In order to work with ChemStation and the
Report Viewer at the same time, you can resize and position both windows
in such a way that you can see them both. When you close ChemStation,
the windows' size and positions are saved. When you launch ChemStation
the next time, the same settings will be used again.

Arranging the Report Viewer Windows

The Report Viewer windows are always displayed on top of the
ChemStation application. In order to work with ChemStation and the
Report Viewer at the same time, you can resize and position both windows
in such a way that you can see them both and can work conveniently.

When you close ChemStation, the windows size and positions are saved.
When you launch ChemStation the next time, the same settings will be
used again.
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Working with the Report Viewer

You can use the Report Viewer, for example, in the following workflows:

You set up the method and the sequence to save PDF reports to the file
system. After completing the sequence run, you open the report files
(sequence summary report or single injection reports) directly from the
ChemStation in the Report Viewer. Use the Adobe Reader features such
as zooming or searching to check the report in detail.

You download a sequence that already contains report files from central
data storage.

To look at the final result, you select the relevant sample in the
Navigation Table and open the report file directly from the
ChemStation in the Report Viewer.

If required, you can change the method and reprocess the sequence.
While the reprocessing is ongoing, you start viewing the reports of
the already completed samples.

In the Report Viewer, you can select both old an new report from the
list at the top left corner. You can distinguish the reports by their
creation date, which is shown as a part of the list entry. Depending
on the transfer settings, the data - including the new report files -
may be automatically uploaded to central data storage after
reprocessing has finished.

You run a sequence that saves only TXT report files. You can check
these report files as well in the Report Viewer.

You review different reports on the same sequence samples, based on
different report styles or templates.

First, you create a sequence with an extended performance report. You
run or reprocess the sequence to obtain the report file. If you are
satisfied with the results displayed in this report, you change the
sequence method to create a shorter report (for example, select a
different report template or the classic report style Short). Then you
reprocess the sequence to obtain the shorter reports. When you view a
report with the Report Viewer, you can switch between the two
different reports by selecting them from the list in the top left corner.
The creation date of each file is shown as part of the list entry.

ChemStation Concepts and Workflows



Data Analysis and Review Concepts 6

Review

In Agilent OpenLAB CDS ChemStation Edition, a new view is available
that covers the pure data review workflows of Data Analysis. In this
Review view, you can generate reports for either an entire sequence, a
subset of a sequence, or any selection of data files from different
sequences or single samples.

In the Review view, you do not load any methods and you do not create

any new results as in recalculation or reprocessing. The reports that you
generate in the Review view only display the results that have already been
calculated.

You can select a report template and apply it to specific selection of data
files. The combination of template and data file selection determines the
output of the generated report.

The Review view is only available if you activated Intelligent Reporting in the Instrument
Configuration in the OpenLAB Control Panel.

Requirements for Intelligent Reporting

ChemStation C.01.06 generates the result data in a specific format
(*.ACAML) that is used by Intelligent Reporting. If you want to create
reports for data acquired with a ChemStation Version A or B, you must
first regenerate results using ChemStation C.01.06 (for example,
recalculate the data or generate single injection reports in the Data
Analysis view). If the results are not available in the required format, the
generated reports in the Review view will not contain any data.
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Data File Selection

You can select the required data files by loading the sequences or single
runs from the Navigation Tree in the ChemStation Explorer. All available
data files are then shown in the Navigation Table. In the Navigation table,
you select the specific data files for which you want to see the results in
the report.

Loading Data Files

You can load all data files from an entire sequence or Single Runs folder.
In the Data tab of the ChemStation Explorer, you can either double-click
the sequence or use the Load command from the context menu to load all
included data files.

When you load the data files, the Navigation Table is automatically cleared
before the new data files are shown. You can therefore prepare the data
for either a Single Sample Report or for a Sequence Summary Report.

Adding Data Files

If you want to compare the results from different sequences, you can first
load one sequence, and then add the required data files from another
sequence. In the Data tab of the ChemStation Explorer, use the Add Data
Files... command from the context menu to add only specific data files to
the selection already loaded. A dialog opens in which you can select the
required data files.

When you add data files, the Navigation Table appends the data files to
the list of data files already loaded. You can therefore prepare the data,
for example, for Cross-Sequence Reports.

Selecting Data Files for Reporting

The Navigation Table shows all data files from the sequence or single
sample collection that you double-clicked in the ChemStation Explorer. In
the Navigation Table, you select those data files for which you want to
create the report. Only the selected lines will be included when you
generate a report.
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Report Template Selection

You can select the required report templates from the Report Templates tab
in the ChemStation Explorer. The Navigation Tree shows all report
templates in the chem32/repstyle directory.

Report Preview

The resulting report is always determined by both the data selection and
the report template. Therefore, ChemStation generates the corresponding
report and displays the report preview once you have selected one or
more data files and loaded a report template.

You can send the report to a printer or save it as a file (PDF, XLS, DOC,
or TXT). If you use a central data storage system, you can also upload the
report directly to the central repository.

Possible Review Workflows

You can use the Review view for example in the following workflows:

* You load a sequence and select all data files of the sequence. You load
a report template and generate a sequence summary report.

* After generating a sequence summary report, you load a different
report template. You review the same data using a different report
layout.

* You load a sequence and select only a subset of data files. You load a
report template and generate a sequence summary report for only part
of the sequence.

+ After loading a subset of data files, you add other data files (from a
sequence or from a collection of single samples). You load a report
template and generate a cross-sample or cross-sequence report.
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Definition of Terms

Calibration  Calibration is the process of determining response factors used to
calculate absolute component concentrations by injecting specially
prepared calibration samples. The calibration table is also used for
identification.

Compound A chemical compound can comprise several peaks, in a multiple signal
calibration, typically one per signal. In a single signal calibration a
compound refers to one peak.

Calibration Level A calibration level comprises the calibration points for one calibration
sample concentration. In a multisignal calibration the calibration points
can be distributed over several signals.

Calibration Point A calibration point refers to an amount/response ratio for a peak on the
calibration curve.

Calibration A calibration sample, also referred to as a calibration standard or a
Sample standard mixture, is a sample containing a known amount of the
compound to quantify. In the software the calibration sample is referred
to as an injection from the calibration sample vial.

Calibration samples may be purchased from chemical suppliers or they
may be prepared using an accurately measured amount of the pure
compound. The amount of the compound in the calibration sample is
usually expressed as a concentration, typically in ng/ul units.
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Types of Calibration

ChemStation offers two types of calibrations, single-level and multilevel
calibrations.

Single-Level Calibration

The calibration curve shown in Figure 40 on page 161 contains one point,
that is, one level. For the single-level calibration curve, the response of
the detector is assumed to be linear over the working range of
concentrations for the samples of interest. The response factor for a given
component peak is given by the inverse of the slope of the calibration
curve line through the point and the origin. A disadvantage of single-level
calibration is that the detector response to the sample concentration is
assumed to be linear and pass through the origin on a concentration
versus response plot. This is not always true and can lead to inaccurate
results.

Response

100

Calibration curve

Concentation [ng/pl]

Figure 40  Single-level calibration curve
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To obtain accurate quantitative results, a calibration curve should have at
least two levels. These levels should bracket the amounts expected to be
found in the unknown samples.

Response

1000 Calibration curve

Concentration [ng/pl]

Figure 41  Two-level calibration curve

For example, if you want to quantify a compound, and the unknown
samples are expected to range from 1 - 10 ng/ul, then a calibration curve
should have at least the two levels as shown in Figure 41 on page 162.

Amount Limits

ChemStation allows you to define the valid quantification ranges in terms
of absolute amounts for each component.

Multilevel Calibration

Multilevel calibration can be used when it is not sufficiently accurate to
assume that a component shows a linear response or to confirm linearity
of the calibration range. Each calibration level corresponds to a calibration
sample with a particular concentration of components. Calibration samples
should be prepared so that the concentration of each component varies
across the range of concentrations expected in the unknown samples. In
this way it is possible to allow for a change in detector response with
concentration and calculate response factors accordingly.

ChemStation Concepts and Workflows



Calibration 7

This multilevel calibration curve has three levels and shows a linear fit
through the origin. This method of linear fit through the origin is similar
to the single-point method calibration. The detector response to
concentration is assumed to be linear. The difference between the two
calibration types is that, with linear fit, the slope of the detector response
can be determined by a best fit through a number of points, one for each
level.

Response

Calibration Curve

1000

500

100

Concentration [ng/pl]

Figure 42  Multi-level calibration curve with three levels

The corresponding calibration table, which is the tabulation of the
information used to generate this curve, might look similar to the one
shown in Table 18 on page 163.

Table 18 Calibration Table

Level Amount (ng/pl) Response (area counts)
1 1 100

2 5 500

3 10 1000

In this example, the calibration samples that were used to generate the
three levels had been identified as 1, 2 and 3.

ChemStation Concepts and Workflows 163



7

164

Calibration

Calibration Ranges

Each multilevel calibration is valid over the range of concentrations used
in the calibration samples. Extrapolation of a calibration curve, especially
if it is non-linear, is at best an approximation. The valid calibration range
for each compound may be defined in the Compound Details dialog box.
Each entry for that compound can be expressed as lower and upper limits.
If these limits are exceeded, the report is annotated.

Calibration Curve Fits

Various curve-fit calculations are available for use with multilevel
calibration.

* Piecewise Linear
* Linear

* Log

* Power

+ Exponent

* Quadratic

* Cubic

* Average (Response/Amount)

Non-Linear Fit

In some cases, the detector response to changes in sample concentration
is not linear. For these types of analyses, a linear regression calibration

method is not appropriate and a multilevel calibration calculation should
be used.
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Origin Treatment

There are four ways to treat the origin when the response curve is
plotted:

¢ ignore the origin,

* include the origin,

+ force the origin, or

* connect the origin.

To force the origin to be included in the calibration curve the calibration
points are mirrored about the origin from the first quadrant into the third
quadrant. Using all points for the regression calculation ensures that the

resulting calibration curve passes through the origin. This is also explained
in Figure 43 on page 165.

Response

1000+ Calibration (&

e

Vs

100+ o~

U 5 10
Amount (ng/pl)

0

Figure 43  Forcing the origin to be included

For further information about calibration curve fits and origin treatment,
see the online help file.
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Calibration Point Weighting

When setting up your default calibration curve, you can specify the
relative weighting (or importance) of the various calibration points used to
generate the curve.

The following weighting options can be selected:

Weight Description
Equal All calibration points have equal weight in the curve.
Linear (Amnt) A calibration point with the amount x has the weighting 1/x normalized to the

smallest amount so that the largest weight factor is 1. Normalization is done
by multiplying the weight with the smallest amount. For example the weight of
a calibration point with the amount x is (1/x) x a where a is the smallest
amount of the calibrated compound prepared in the calibration standards.

If the origin is included it is assigned the mean of the weightings of the other
calibration points.

Linear (Resp) A calibration point with the response y has the weighting 1/y normalized to
the smallest response so that the largest weight factor is 1. Normalization is
done by multiplying the weight with the smallest response. For example the
weight of a calibration point with the amounty is (1/y) X b where b is the
response corresponding to the smallest amount of the calibrated compound
prepared in the calibration standards.

If the origin is included it is assigned the mean of the weightings of the other
calibration points.

Quadratic (Amnt) A calibration point with the amount x has the weighting 1/x2 normalized to the
smallest amount so that the largest weight factor is 1. Normalization is done
by multiplying the weight with the smallest amount. For example the weight of
a calibration point with the amount x is (1/x2) x a* where a is the smallest
amount of the calibrated compound prepared in the calibration standards.

Quadratic (Resp) A calibration point with the response y has the weighting 1/y? normalized to
the smallest response so that the largest weight factor is 1. Normalization is
done by multiplying the weight with the smallest response. For example the
weight of a calibration point with the response y is (1/y?) x b? where b is the
response corresponding to the smallest amount of the calibrated compound
prepared in the calibration standards.

# Calibrations A calibration point is weighted according to the number of recalibrations of
the point. No normalization is done.
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Quadratic calibration point weightings, for example, can be used to adjust
for a spread in calibration points. It makes sure that calibration points
closer to the origin, which can normally be measured more accurately, get
a higher weight than calibration points further away from the origin,
which may be spread.

You should base your decision, which kind of calibration point weighting
to use, on your method requirements.
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The calibration table specifies conversions of peak areas or heights into
the units you choose according to the calculation procedure you select. It
contains a list of retention/migration times from a calibration run. These
retention/migration times are compared with retention/migration times of
peaks from a sample run. Where a match occurs, the peak in the sample
is assumed to represent the same component as that in the calibration
table. During an analysis or while a report is being generated, the
amounts entered for each peak are used to calculate the amounts for the
calculation procedure selected for the report. The type and amount of
information required for creating a calibration table varies with the type
of calculation procedure desired.

The following information is needed to create a calibration table:

* the retention/migration time for each calibration mixture component
peak, and

* the amount of each component used in making the calibration mixture,
expressed in consistent units.
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Peak Summing

The peak sum table is provided for certain applications in the
petrochemical and pharmaceutical industries that can be performed more
effectively with the following features:

* Sum the areas of peaks that lie within a range specified by the user

* Sum the areas of a range of peaks and perform the calculations using a
single multiplier

* Sum the areas of all peaks having the same name

The peak sum table is similar to, but distinct from the standard
calibration table. Like the calibration table, it is associated with the
current method.

You must create a calibration table for an analysis before you can create the peak sum
table.
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Unknown Samples

An unknown sample is a sample containing an unknown amount of the
compound to be quantified.

To find out how much of the compound is in the unknown sample, you
must:
* create a calibration curve for the compound,

* inject an aliquot of your unknown sample and run the analysis in
exactly the same way as for the calibration sample,

* determine from the signal the response, which is the area or height of
the peak due to the unknown amount of the compound, and

* use the calibration curve to calculate the amount of the compound in
the unknown sample.

For example, if the area of peak in the unknown sample is 500, you can
determine that the amount in the unknown is 5 ng/ul, by using the
calibration curve shown in Figure 44 on page 170.

Response Response
1000 -
Area =500 Pt
Response of _/’/ Amount of
unknown ~ unknown
f =500 = ng/pl
| \ /
| &
J N\
| ] //. | J
5 10 b 10
Time (min) Amount (ng/pl)

Figure 44  Signal from Unknown Sample and Calibration Curve
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Recalibration

What is Recalibration?

Recalibration is the process used when you want to update a level on a
calibration curve. When you recalibrate you run another sample that
contains the same calibration compounds as the original, and most
important, the same amount of these compounds. When you run the
calibration sample, you obtain updated response factors and
retention/migration times. You may also choose to average the response
factors over a number of calibration runs so that response factors are
weighted equally.

Why Recalibrate?

Most calibrations have a limited lifetime, due to changes in
chromatography. Recalibration is necessary to maintain the accuracy of
the analysis. For example, assume you have created a calibration table for
the compound caffeine which you use whenever you are required to
quantify samples containing caffeine. At some point you will need to
replace the column/capillary. Although the column/capillary is replaced
with exactly the same type, it will not behave in exactly the same way as
the previous column/capillary when you first created the calibration table
for caffeine. Therefore, to ensure consistency you should recalibrate the
levels in the calibration table before using the new column/capillary to
analyze samples containing unknown amounts of caffeine. By doing this
you are quantifying samples analyzed under the same system conditions.

Manual Recalibration

You can enter peak calibration information manually and normalize the
calibration table using the Manual Setup option button in the New
Calibration Table dialog box. Typically, a new calibration method is
produced by running a calibration standard mixture, creating a calibration
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table, and entering the amounts of all calibrated peaks to obtain response
factors. This approach is inefficient for some application, such as found in
the petrochemical industry, where the same compounds have been
analyzed for many years and the response factors for various compounds
and detectors are readily available.

You create the calibration table manually by entering peaks and their
response factors into the calibration table, recalibrating the method using
a standard that contains at least one response reference peak, and
selecting Delta% update.

To reference to a specific peak for the calculation of retention time ratios,
you can set this peak as a retention time ratio reference peak. All peaks
with the same RT Ratio Ref # are then referenced to this peak.

Recalibrations with Peak Summing

When a recalibration is performed, the retention/migration time ranges in
the Peaksum Table of the method will be updated before the actual
recalibration is done. Peak Sum recalibrations are performed in this way
to ensure the delta is incorporated into the time calculations.

Ways to Recalibrate

Recalibration can be done in two ways using the ChemStation software.
You can recalibrate interactively or automatically during a sequence of
automated analyses. Interactive recalibration is when you directly go
through the process of recalibration using the ChemStation software after
injecting one or more calibration samples. Recalibration using a sequence
is where you specify when the recalibration occurs, but the automation
software does the recalibration. For more information refer to “Automatic
Recalibration” on page 112.

For information on how to perform recalibration using the software, see
the How To part of the help system.
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Recalibration of Unidentified Peaks

There are three ways to recalibrate unidentified peaks.

No Recalibration

If a peak in the calibration table cannot be identified in the integration
results, the calibration is aborted. If this occurs in a sequence, the
sequence is also aborted.

Partial Recalibration

This feature allows the recalibration of only the identified peaks. If peaks
are missing, the calibration is not aborted but the report is annotated that
peaks are missing.

Recalibration of all Retention/Migration Times

This feature allows the retention/migration time recalibration of all
identified and unidentified peaks. This is done by using the
retention/migration times of the identified peaks. There is no update of
response factors for unidentified peaks.
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This chapter describes the concepts of Intelligent Reporting and Classic
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What Is a Report?

176

A report can comprise quantitative and qualitative information of the
sample you analyze. The report can be a hardcopy printout, a display on
the screen or an electronic file. The report can include details of the
peaks detected during the run and plots of the signals that were acquired.

Reports for different purposes
You can specify reports that serve different purposes during data
acquisition and data review:

* The sequence summary report is defined in the Sequence Qutput tab of
the Sequence Parameters dialog. This report is automatically created by
ChemStation after completing a sequence acquisition or reprocessing a
sequence.

+ The single injection report is defined in the Specify Report dialog. This
report is created for each single sample during a sequence acquisition
or sequence reprocessing.

With Intelligent Reporting, you create templates for different report types,
depending on the purpose of a report. For more information, see “Report
Types” on page 179.

Report destination

A report can be sent to the following destinations:
+ Screen

The report (including text and graphics) is displayed on the screen in
the report preview window, from which it can be printed.

*  Printer

The report comprising text and graphics is printed on the currently
selected printer.

* File

The report is saved to a file, for example, an Adobe PDF file.
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Classic and Intelligent Reporting

With Agilent OpenLAB CDS, you can choose the type of Reporting you
want to use: Classic Reporting as it was used in the previous
ChemStation versions, or Intelligent Reporting that provides a powerful
standardized report definition language and improved reviewing functions.
The following sections describe the two types of reporting.

Consequences of Activating Intelligent Reporting

If you want to use Intelligent Reporting, you need to enable Intelligent
Reporting in the Instrument Configuration in the OpenLAB Control Panel.

Activating Intelligent Reporting has the following consequences for
ChemStation:

* The Report Layout view shows the Report Template Editor for Intelligent
Reporting.

* The Review view is visible.

+ In the Sequence Parameters dialog, you can choose between Classic and
Intelligent Reporting.

+ In the Specify Report dialog, you can choose between Classic and
Intelligent Reporting.
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Intelligent Reporting
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Advantages of Intelligent Reporting

Intelligent Reporting offers you the following advantages:

You can use the Review view.

Most of the functionality that is available in different settings and
several dialogs for Classic Reporting is now part of the report
templates. You can create or edit report templates using the Report
Layout view, which contains the new Report Template Editor for
Intelligent Reporting. The Report Template Editor offers several
powerful functions:

You can access all result data generated by ChemStation by selecting
the corresponding data field.

You can create your own expressions in order to make calculations
with the data fields. You can use any valid Microsoft Visual Basic
expression.

You can create expressions where you make calculations with the
ChemStation Custom Fields.

Result Flagging: You can provide expressions to highlight specific
results depending on their value.

Snippets: The Report Template Editor provides preconfigured report
items, so-called snippets, that you can insert into your report
template via drag and drop.

You can use the Report Template Documentation Tool to create
descriptions of your report templates.

You can report the following values as defined by European
Pharmacopeia (the peak-to-valley ratio is also available with Classic
Reporting; for details on the required fields, refer to the Reference
Guide):

Signal- to- noise ratio
Relative retention

Relative retention time
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Report Template Editor (RTE) for Intelligent Reporting

Report Types

You can create different types of reports. Depending on the report type,
different data fields are available in a report template, and the report
items are grouped differently.

The following report types are available

+ Single Injection
The generated report shows the report items from the template
separately for each injection in the current data scope. You can show

the data per injection, but you cannot compare results from different
injections in one table or matrix.

+ Single Sequence Summary

The generated report shows the report items from the template
separately for each of the sequences in the current data scope. You can
compare results from different injections in one table or matrix, but not
the results from different sequences.

+ Cross-Sequence Summary

With this report type, the data is not automatically grouped. Therefore,
you must pay more attention to the grouping of your report items, but
in return you can create report items that compare data from different
sequences.
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Template Format

All report templates are based on the Report Definition Language (RDL),
which is a standardized XML format provided by Microsoft.

To create report templates, you can either use the Report Template Editor
(RTE) or Microsoft SQL Server Business Intelligence Development Studio
(BI Studio):

* RTE provides an easy-to-use interface that helps you create report
templates in a few steps. It supports all types of report items and most
of the respective configuration options.

With RTE, you cannot edit templates that have been created with BI
Studio. If you need to edit such templates in RTE, please ask Agilent
Customer Service.

* BI Studio provides the complete range of functions. However, working
with BI Studio requires advanced knowledge of template development.
For more information, please refer to G4635- 90007 Manual for Report
Template Designers. This manual comes with OpenLAB ECM Intelligent
Reporter. Please contact Agilent to receive a copy of this manual. This
manual also contains detailed descriptions of the Agilent report
templates that are delivered with OpenLAB ECM Intelligent Reporter.
These templates are specifically designed for usage in BI Studio and
contain most of the advanced features that are not available in RTE.

In BI Studio, you can edit any report template, no matter whether it
was created with RTE or with BI Studio.

Data Fields

You can access all result data generated by ChemStation during an
acquisition. For each value you can select the respective data field in
which the value is stored. You can arrange the data fields in the report
template according to your requirements. The available data fields are
arranged in the following categories:

* Sequence
* Sample

* Injection
» Signal

* Compound
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* Peak

+ Calibration Curve
* Instrument

+ File

* Project

Report Items

You can add various report items to a report template, depending on your
requirements. For each report item you can configure several properties
such as the font format, background color, expressions, etc. The following
report items are available:

* Text Fields

* Data Fields

* Tables

* Matrices

* Composite Groups
* Images

* Chromatograms

+ Calibration curves
* Spectra

* Charts

* Method Information

Snippets

The Report Template Editor provides snippets, multiple preconfigured
report items or groups of report items, which you can insert into your
report template via drag and drop.

These snippets are, for example, preconfigured tables for compound
results or system suitability, chromatograms for a single signal plot or
multi signal plot, or control charts for calibration accuracy or retention
time stability. You can use the snippets as a starting point and adjust
them according to your requirements.
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Custom Calculation

In the Report Template Editor, you can either display the values of the
data fields as they were generated by ChemStation, or you can calculate
new values for different purposes. You can create expressions using the
existing data fields and also using the custom fields.

You can store the values as variables and access these variables from a
subsequent report item in the template.

The Report Template Editor provides an Expression Editor that helps you
to create valid expressions. All expressions are based on Microsoft Visual
Basic.

Conditional Formatting

You can configure certain properties of a field or cell, depending on the
values resulting from the expression. For example, if the compound
amount is shown, you can create a condition for a red background if the
amount exceeds a certain value.

Demo Data

When you develop a new report template in the Report Layout view,
ChemStation provides the demo data that is shown in the Report Template
Editor when you edit or preview a template. The demo data corresponds
to the data set (sequence or single runs) that is currently selected in the
Navigation Table of the Data Analysis view. If you develop a template for a
sequence summary report, you need to load a sequence in the Data
Analysis view and select a subset of samples. If you develop a template for
a single injection report, it is sufficient if you select only one sample in
the Data Analysis view.
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Storage of Report Templates

ChemStation provides a number of predefined report templates. These
default templates are located in the directory chem32\repstyle.

For sequences, the report templates used for sequence summary reports
and single injection reports are located in the result set on the same level
as the sequence methods. No report templates are stored on the data file
level of a sequence.

For single samples, the report template is located in the data file.

Browse Templates Dialog

If you browse for report templates in the Sequence Parameters dialog or in
the Specify Report dialog, you can synchronize the templates in the Default
Templates directory and in the result set.
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Browse for Report Templates in Result Set

Master Templates Fiesult Set Templates

Template @ Last saved o Template @ Last saved
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.j GLP+Shart G/10/2010 10:48:42 &AM
J Sample_Summary  §/10f2010 10:48:56 AM @
5] short B/10/2010 10:45:46 AM@

J Short_aAcquisition B/10/2010 10:48:52 AM
J Short_aAcquisition...  §/10/2010 10:49:02 AM
J Short_aAcquisition...  §/10/2010 10:49:04 AM
J Short_aAcquisition...  §/10f2010 10:45:48 AM
J Short_Amount 8/10/2010 10:49:06 AM

-] Short_area 8/10,/2010 10:49:08 AM
J Short_Quantification §/10/2010 10:48:54 AM
e P @
5] calibration B/10/2010 7:37:16 PM
.j Extended_Seq... §/10/2010 7:37:16 PM
Ij GLP+Short B/10/2010 7:37:118 PM

.j Sample_Summ... /102010 7:37:20 PM

5] short B/10/2010 7:37:20 PN@
.j Shart_Acquisit... &/10/2010 7:537:22 PM

.j Short_Acquisit, .. §/10f2010 7:37:22 PM

.j Short_Acquisit, .. 8102010 7:37:24 PM

.j Short_Acquisit, .. 8102010 7:37:24 PM

.j Short_Amou... 8/10/2010 7:37:26 PM
.j Short_Area 8/10/2010 7:37:28 PM
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CaLanGUAGE
-1 dzh-cHs
51 Calibratinn AANMPO10 7:47:0A P

-

[] Shaw anly comman templates [ 0K, ] [ Cancel ] [ Help

Figure 45 Browse for Report Templates in Result Set dialog

1 On the left side, you see the templates in the Default Templates directory
(chem32/repstyle).

2 On the right side, you see the templates in the currently loaded result set.

3 For each template, you see the date when it was last saved. The tooltip of the date shows

the template's last history entry.
4 Templates can also be stored in subfolders of chem32/repstyle.

5 Templates that are common for the result set and the Default Methods directory are shown
in bold. The templates are matched only by name.

6 You can copy templates from the Default Templates Directory to the result set either by
using Drag&Drop or by using the > button.
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Data file management with Unique Folder Creation OFF

8

Using the Unique Folder Creation OFF option, the templates for sequence
summary reports and single injection reports are always referenced from
the Default Templates directory (chem32\repstyle).

Storage of Generated Reports

File Naming for Single Injection Reports

When you provide a file name for the single injection report in the Specify
Report dialog, you can use the following tokens:

<Date> current date

<Time> current time

<SeqN> sequence file name (will be “_” for a single sample)
<Cont> name of result set (will be “_” for a single sample)
<SamN> sample name

<Lims> LimsID

<InjD> injection date & time

<File> data file name

<SLoc> sample location

File Naming for Sequence Summary Reports

When you provide a file name for the sequence summary report in the
Sequence Output tab of the Sequence Parameters dialog, you can use the
following tokens:

<Date> current date
<Time> current time
<SeqN> sequence file name

<Cont> name of result set
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Report Templates in Central Data Storage

If you use a central data storage system, report templates are treated as a
separate document type. You can upload templates to central data storage,
download templates from central data storage, or update all local report
templates with the latest version from central data storage.
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Classic Reporting

Reporting Results

Two types of reports are available:

* an uncalibrated report which does not correct for detector response,
and

* a calibrated report that shows results corrected for the difference in the
detector response to various components of the sample.

Uncalibrated Reports

The uncalibrated reports include the Area% and Height% reports. These
reports are mainly used in the preparation of calibrated reports. They may
be of value as a final report if the amounts of compound required to
produce a unit area or height response for the compounds of interest are
similar.

Calibrated Reports

Calibrated reports correct for the difference in the detector response to
the reported compounds. One or more calibration samples containing
known amounts of the reported compounds must be run under the same
conditions used for the unknown sample. The integration data from these
calibration sample(s) are used to prepare a calibration table. This is a list
of retention/migration times, amounts and responses which is used in the
generation of the report. The calibrated reports are based on two
calibration procedures called external standard and internal standard.

External Standard Report

The ESTD report lists the results with the units of your choice or with
each compound as a percentage of all the compounds present. The
external standard procedure requires that the relative injected volume of
both the calibration and unknown samples must be known accurately. The
reliability of the external standard report is limited by the reproducibility
of the injection and any other factors that might change from sample to
sample.
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Internal Standard Report

The limitations of the external standard procedure can be overcome by
using the internal standard approach. An accurately known amount (not
necessarily the same amount) of the internal standard is added to both
the calibration sample(s) and unknown sample. The response of each
compound of interest is divided by the response of the internal standard
to give a response ratio. The calibration curves are a plot of this response
ratio versus the amount ratio and this information is used in the
calculation of the reported results. In this way inadvertent errors in
injection volume or slight changes in the
chromatographic/electropherographic system that affect all compounds
similarly are cancelled out. The ISTD report lists the results with units of
your choice.

Control Charts Report

The Control Charts Report tracks a single result from multiple runs for a
specific calibrated compound. The Control Chart feature is installed after
ChemStation is operational. Methods that use this feature pass the tracked
result to a Microsoft Excel work sheet after each run. Excel is then used
to print the report.

Quantitative Results

The report type is identified by the name of the calculation method used
to prepare it, for example, an ISTD report. Each type is briefly described
below. The calculations for each report are given in “Quantitative
Results” on page 188.

Area% provides the simplest report and requires no calibration data since
no correction is made for the difference in detector response of sample
components. The Area% report is particularly useful in developing a
calibration table for use with the other report options. This report is
suitable for analyses in which the difference in detector response of the
components is not significant.

Height% gives a report similar to the Area% report except that peak height
is used for the calculations instead of peak area.
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Norm% gives a report in which each component is reported as a
percentage of all the components present. The peaks are corrected for
detector response before calculation of the percentage of each.

ESTD produces a report of the actual amount of each substance in
whatever units you choose. Amounts are calculated using a previously
established calibration table. The use of an external standard requires that
the injected volume of the calibration mixture be known.

ESTD% produces a report of the relative amount of each substance as a
percentage of the injected sample. Amounts are calculated using a
previously established calibration table. The use of an external standard
requires that the injected volume of the calibration mixture be known.

ISTD produces a report of the actual amount of each substance. Amounts
are calculated using a previously established calibration curve. The use of
an internal standard in both the sample and the calibration mixture
eliminates the need to know and control the volume of the sample
injected. This also corrects for any variation in instrument performance
between runs.

ISTD% produces a report of the relative amount of each substance as a
percentage of the injected sample. The use of an internal standard in both
the sample and the calibration mixture eliminates the need to know and
control the volume of sample injected. This also corrects for any variation
in instrument performance between runs.

Reporting Custom Field Values

The values of the custom fields attached to a certain sample according to
its acquisition method can be added to the report. Sample custom fields
are listed at the end of the report header that contains the general sample
information. Compound custom fields appear at the end of the report.

Report Styles

You choose to add a signal to any of the report styles by checking the
appropriate box in the Specify Report dialog box.
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The following report styles are available:

None - No text will be reported. The chromatogram will be reported
only if the Add Chromatogram Output option is selected.

Short - Comprises quantitative text results of all integrated signals
which are setup in the Signal Details dialog box (LC only) or the Signal
dialog box (GC only). The peak width in the short report is calculated
with the more complex formula used by the integrator: PW =
0.3(IPRight - IPLeft) + 0.7(Area/Height) where IPRight and IPLeft are
the inflection points.

Detail - Comprises header, quantitative results, and calibration curves.
The header is stored in a file called RPTHEAD.TXT in the method
directory. You can change the header using a text editor to include a
method specific text.

Header + Short - Comprises file header and quantitative text results. The
header is stored in a file called RPTHEAD.TXT in the method directory.
You can change the header using a text editor to include a method
specific text.

GLP + Short - Comprises header, sample information, instrument
conditions, logbook, signal, and quantitative results. The header is
stored in a file called RPTHEAD.TXT in the method directory. You can
change the header using a text editor to include a method specific text.

GLP + Detail - Comprises header, sample information, instrument
conditions, logbook, signal, quantitative results, and calibration curves.
The header is stored in a file called RPTHEAD.TXT in the method
directory. You can change the header using a text editor to include a
method specific text.

Full - Comprises header, sample information, instrument conditions,
logbook, signals, and quantitative results. The header is stored in a file
called RPTHEAD.TXT in the method directory. You can change the
header using a text editor to include a method specific text.

Performance - Produces a report according to the limits specified in the
Edit Performance Limits dialog box of the System Suitability menu.

For uncalibrated methods, the report parameters include the peak
number, retention/migration time, peak area, peak height, signal
description, true half-height peak-width (please refer to True Peak
Width Wx [min] in the Reference Guide), symmetry, k’, efficiency
(plates) and resolution for each peak.
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For calibrated methods, the report parameters include the peak number,
retention/migration time, compound name, amount, signal description,
true half-height peak-width, symmetry, k', efficiency (plates) and
resolution for each peak.

The half-height peak calculation is not the same as the more complex
peak width formula used by the integrator. The values of efficiency and
resolution are based on this calculated peak width. The report header
consists of all method relevant information, including instrument,
column/capillary, sample, and acquisition parameters. The signal is also
plotted.

* Performance + Noise- Combines the Performance report style with the
noise calculations for the noise ranges defined in the Edit Noise Range
dialog box of the System Suitability menu. In addition, the noise, given
as six times the standard deviation, as peak-to-peak, and as ASTM
noise.The drift and wander is also determined.

* Performance + Extended- Produces an extended report with all the
parameters from the peak performance calculations and individual plots
of each peak. The plots include the baseline, the tangents, and the peak
widths at defined heights. This report type includes only calibrated
peaks.

In addition to the parameters printed for the Performance report style,
more Peak Performance Parameters are determined: the peak start and
end peak times, skew, excess, peak width, USP tailing factor, time
interval between data points, number of data points, statistical
moments, plates, plates per meter, selectivity and resolution of each
peak are printed. The peak width, plates, plates per meter, selectivity,
and resolution are calculated by the true half height, 5 sigma, tangent
and tailing methods (please refer to Performance Test Definitions in
the Reference Guide for details).

The report header consists of all method relevant information such as
instrument, column/capillary, sample and acquisition parameters and a
plot of the signal. For a complete list of the peak performance
parameter algorithms refer to Performance Test Definitions in the
Reference Guide for details.

The spectral report styles (Short + Spectrum, Detail + Spectrum, Performance +
Library Search) are described in Understanding Your Spectra Module.
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Adding a Customized Report to Report Styles

You can add a custom report template that you have created in the Report
Layout view of ChemStation to the list of available report styles.

All reports apart from the performance reports list the peakwidths calculated with a more
complex formula by the integrator (for details on the peakWidth calculation please refer to
Peak Width in the Reference Guide).

Other Report Style Parameters

Summed Peaks Table

The peak sum table is provided for certain applications in the
petrochemical and pharmaceutical industries that can be performed more
effectively with the following features:

* Sum the areas of peaks that lie within a range specified by the user

* Sum the areas of a range of peaks and perform the calculations using a
single multiplier

* Sum the areas of all peaks having the same name
When the report is generated, ChemStation uses the peak sum table to
produce a peak sum report that is printed after the standard report

calculations with the exception of Norm?% which is replaced by the peak
sum report.

Report Layout for Uncalibrated Peaks
To change the report layout for uncalibrated peaks, choose one of the
following in the Specify Report dialog box.

* Separately to report the uncalibrated peaks in a separate table if
sorting by retention/migration time is selected, or separate tables if
sorting by signal is selected.

* With Calibrated Peaks to report the uncalibrated peaks together with
the calibrated peaks.

* Do Not Report to suppress the reporting of uncalibrated peaks.
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Sequence Summary Reporting

Overview

ChemStation can print a variety of standard reports for individual sample
analyses. Sequence summary reporting is an additional way of reporting,
that allows you to calculate and report parameters across a number of
different analyses. It is useful, for example, to test the stability of an
instrument or the robustness of a new method.

A sequence summary report may include:

* a title page,

* instrument configuration, including the revision numbers of the
instrument and details of the analytical column/capillary being used,

* sequence table listings which describe what the automated sequence of
analyses should have done,

* logbook descriptions of what the sequence actually did and any
unexpected events which occurred during the sequence,

* method listings,
* individual reports on each sample,

+ statistics on the analyses based on selected criteria—statistics are
calculated only for calibrated compounds, and

* a table of contents with page number references to the detailed sections
of the report.
Setting up a Sequence Summary Report

When setting up a sequence summary report, you can select any
combination of the following nine categories by activating the appropriate
check boxes and, where appropriate, selecting a report style from the
template selections. Each template specifies the contents and layout of
that particular section of the whole sequence summary report.

You can choose one of the following sequence summary report styles:

One Page Header

The GLP template prints GLP in large letters as a title page for the
following report. It also includes the date and a place for a signature.
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Configuration

Select Configuration if you want to include the instrument configuration and
analytical column/capillary specifications in the report.

Sequence Table

Select Sequence Table to include a list of the samples, sample quantification
parameters and method names in the report. This list shows what the
system should have run.

Loghook

Select Loghook for a listing of the analyses the system ran, including
instrument conditions and any unusual events that occurred while the
samples were being analyzed.

Methods

Select Methods to list all the analytical methods used in the series of
automated analyses.

Analysis Reports

Select Analysis Reports to get individual analysis reports according to the
report style set up for the method.

Individual analytical reports may be printed after each analysis according
to the report style specified for the method in question, in addition to the
report sections specified in Sequence Summary Reporting. See "Sequence
Output" below.

SUILabel Type = Application > Statistics for Calibrated and Sample Runs

Selecting the Statistics cal. runs will produce statistical trend analyses for
calibration samples. Selecting the Statistics sample runs will produce
statistical trend analyses for sample (unknown) analyses. Both selections
have Standard Statistic and Extended Statistic template styles. Extended
Statistics prints the statistical trends of the analyses as graphs, whereas
the Standard Statistics selection prints only text. The selections that you
make in the Items and Limits for Extended Statistics dialog box are used only
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when you choose the Extended Statistic option(s) in the Sequence Summary
Parameters dialog box.

If you choose the Standard Statistic option(s) in the Sequence Summary
Parameters dialog box, then the statistics reported are:

* retention/migration time,

+ area,

* height,

* amount,

* peak width (based on the report style, see “Report Styles” on page 189)
* symmetry.

The statistic calculation does not distinguish between different calibration
levels in a sequence that uses multilevel calibration methods. This means
that the concentration-dependent items, for example, Area, Height,
Amount (see the dialog box for Items and Limits for Extended Statistics)
are all taken together, regardless of the calibration level. The Statistics for
Calibration Runs values are therefore not useful for multilevel calibration
methods in sequences.

Summary

The Summary selection will print an overview of the series of samples
analyzed and the methods used. If the Summary choice is selected
together with other Sequence Summary selections, page numbers referring
to the other parts of the sequence summary report are included. Two
Summary styles are available:

The Sample Summary tabulates details of the sample analyses run in the
sequence, with some sample information such as the sample name, data
file name, method and vial number.

The Compound Summary tabulates the sample analyses with basic
quantification results for each calibrated compound, or each peak,
depending on the type of report specified in the method.
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Sequence Qutput

In the Sequence Output dialog box you can define where the sequence
summary report should be printed.

Select Reportto file and enter a file name to print the report to the
specified file. The default setting is that data are saved to the file
GLPrprt.txt. In GC systems with dual injection the data are saved in
GLPrptF.txt and GLPrptB.txt for the front injector and back injector
respectively.

Select Reportto PDF to save the report as a PDF document. The report is
saved in the sequence folder with the name CLPrprt.PDF

Select Reportto HTM to print the report in HTML format. The report is
saved into an HTM directory in the data directory specified in the
Sequence Parameters. The HTM report consists of an index file (index.htm)
and at least two other files, a contents file (contents.htm) and a GIF
(Graphics Interchange Format) file for each page of the report (e.g.
pagel.gif). To view the html report, open the index file using your
browser.

Select Report to printer to print the report on the system’s printer. Print
individual reports for each run also activates printing of sample reports
after each analysis. These reports are printed in addition to the reports
specified for the sequence summary report which are produced at the end
of the entire sequence. You can specify a new destination for these reports
in the Sequence Output dialog or use the destination specified in the
individual methods.

Report File Formats

IXT
.EMF

A report can be saved in different formats. Each format has a specific
extension. It is possible to select more than one format for a report.

The report text is printed as a UNICODE text file.

Each report graphic (signal or calibration curve) is saved in a Microsoft
Windows metafile (WMF). Several .WMF files for one report are possible.
The generated file format adheres to the Microsoft standard metafile

format as defined in the Windows software development documentation.
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These files are compatible with the Aldus Placeable Metafile (APM) format
used by a number of proprietary software packages.

.DIF The tabular report data is saved in Data Interchange Format (DIF). This
format is accepted by spreadsheet programs, for example, Microsoft
Windows EXCEL. Independent from the report style selected, only the
information contained in the report style Short will be saved.

.SV The report is in Comma Separated Values (CSV) format. This is a very
simple format for tabular data that is accepted by many spreadsheet
programs and databases. Independent from the report style selected, only
the information contained in the report style “Short” will be saved.

There can be several .DIF and .CSV files for a single report. For each
report block, the first file, for example, REPORTO00.CSV, contains the
report header information. Subsequent files contain the tabular results.

If the results are sorted by retention/migration time, only one file is
required for the complete table, for example, REPORTO01.CSV.

If the results are sorted by signal, a separate table is required for each
signal. In this case, the files are named Report01.CSV through
ReportNN.CSV, where NN is the number of the signal.

XLS The report is exported to a Microsoft Excel spreadsheet in (XLS) format.
The data generally requires additional processing.

.PDF The report is printed to a .pdf file. The ChemStation setup installs a PDF
printer, called "PDF-XChange 4.0". This Printer will only be visible in the
Start Menu/Settings/Printers and Faxes until the computer is restarted. When
ChemStation is started, another temporary printer is created called
"ChemStation PDF" based on the PDF-XChange printer. While any
ChemStation session is running, ChemStation PDF will be listed in the
Start Menu/Setting/Printers and Faxes. The option Unique pdf file name allows to
store the .pdf reports independent of the reports, with file names
<sequence_container_name>_<data_file_name>.pdf
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This chapter is relevant only if you use ChemStation to control CE instruments.
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CE Agilent ChemStation Specific Functions in Method and Run
Control View

200

Vial Table

Don’t Care
Method

Sequence

The Vial Table functionality is available in the online ChemStation session only.

The Vial Table is a table that associates vials in the vial tray with samples,
and, more importantly, with task specific vials such as buffers, flush vial,
clean tubes vial, and the waste. The Vial Table is linked to the Sequence
Table. When a sequence is loaded, the information from the Sequence
Table is copied into the Vial Table. However, Vial Table entries are not
transferred back into the Sequence Table. The Vial Table Advanced Settings
dialog box is displayed when you choose the Advanced button in the Vial
Table. It allows you to enable warnings of conflicts between the Vial Table
and the method or sequence and the use of symbolic names. You must
select Enable vial table checks and warnings to check for conflicts between the
Vial Table and the method and sequence.

When a method or a sequence is loaded, a consistency check is made
between the vial allocations in the Vial Table and those in the method or
sequence. If there are any vial conflicts they can easily be resolved by
using the Conflict tables.

Position 49 in the vial tray is used for the needle wash vial and position 50 is left empty to
allow the vial lift to return. These positions are not available in the Vial Table.

The Used in column of the Vial Table enables the usage of the vial to be
specified. There are five valid entries for the Used in fields:

No consistency check is made
The vial is referenced in the method

The vial is referenced in the Sequence Table
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System This is a special vial belonging to the system configuration. The Name
must be one of the following symbolic names:

* @INLET the inlet vial

* @OUTLET the outlet vial

* @FLUSH the flush vial

+ @WASTE the waste vial

* @clean tubes the vial used for cleaning the replenishment tubes
+ @USER X (where as X can be 1 to 10) the sequence placeholder

This option allows the specification of individual vial numbers for the
symbolic names used in the method. This enables the user to specify
different vials for Inlet Home, Outlet Home, Replenishment,
Preconditioning, Postconditioning, etc. for each line in the sequence.

NotUsed There is no vial in this position

Method Conflict Table

The Method Conflict Table is displayed when you load a method that has
vials defined that conflict with the vials defined in the Vial Table. The
Method Conflict Table has two sides; the left half contains an image of the
Vial Table; the right half shows the conflicting vials.

To resolve the conflicts you can select to either replace (single arrow) or
to move the vial from the method to the next free position in the Vial Table
(double arrow). This can be done for each conflicting vial in the table.

When user-defined vials (with symbolic names @Userl, @User2, etc.) are
used the conflict test cannot be performed on these vials, because without
the sequence information it cannot be decided whether a conflict exists or
not.
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Sequence Conflict Table

The Sequence Conflict Table is displayed when you set up or load a sequence
that has vials defined that conflict with the vials defined in the Vial Table.
The Sequence Conflict Table has two sides; the left half contains an image of
the Vial Table; the right half shows the conflicting vials.

To resolve the conflicts you can select to overwrite the Vial Table
information with the information from the Sequence Table, or if the conflict
is caused by a system entry it cannot be overwritten. You can select to
close the Sequence Conflict Table without resolving the conflicts.

When user-defined vials (in the columns Userl, User2, etc.) are used the
conflict test cannot be performed on these vials, because without the
method information it cannot be decided whether a conflict exists or not.

Method Simulation

You can use the simulation function to check your method. During
simulation the diagram reflects the actions that would be performed
during the method, i.e. the vials specified in the method are shown in the
lifts, power and voltage applied is shown as it would during an actual run.
Simulation is faster than running an analysis - each step takes about 3
seconds. A step is defined by a change in the CE diagram.

To start simulation, load the method you want to simulate and select
Simulation from the Instrument menu.

ChemStation Concepts and Workflows



CE specific Concepts and Functions 9

Peak Top Type

Unlike LC, GC, or MS peaks, it is quite normal for CE peaks to be
asymmetrical. Because of this, is very important to have the ability to
select integration parameters that will yield the highest level of accuracy
and reproducibility in your quantitation results.

The following peak top types are available when selecting Peak Top Type in
the Integration drop-down menu:

Highest Point

* select when the peak is triangular, and

* when you work with different concentrations

Parabolic Interpolation

* use for tailing, unseparated peaks

Center of Gravity

* provides more accurate calculations with triangular shaped peaks

* samples with similar concentrations

Gauss Fit

* use for symmetric peaks
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Calibration Types

204

Standard Calibration is based on peak area or peak height. When you
select Standard Calibration you have the option to Calculate Signals Separately
or Calculate with Corrected Areas.

Calculate Signals Separately is selected when you want to ensure that, in
the calculation of Norm% reports, the amount percent of separately
reported signals add up to 100% for each signal. When Calculate signals
separately is deselected, the amount percent of all signals add up to 100%.
Selecting Calculate signals separately is a prerequisite for sorting by signal in
the calibration table.

Select Calculate with Corrected Areas to make a correction to the peak area
based on the migration time. In this mode, the area is divided by the
migration time which can improve reproducibility in quantitative analysis
when migration times are unstable.

In addition to the Standard Calibration, there are 3 capillary
electrophoresis specific calibrations that are migration time based one
signal.

The following calibrations types are available in the drop-down list for
your Calibration Table:

+ Standard Calibration
* Protein Molecular Weight Calibration
- DNA Base-Pair Calibration

+ Capillary Isoelectric Focusing Calibration

For more information on the capillary electrophoresis specific calibrations,
refer to OpenLAB CDS ChemStation Edition — Reference to Operation
Principles.
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Migration Time Based Calibrations

Using Migration Time Based Calibrations in a Sequence

Migration time-based calibrations and recalibrations can be included in a
sequence, but only explicit calibrations and cyclic recalibrations are
supported; bracketed recalibration is not supported. There is no Sequence
Summary report with migration time-based calibrations.

Report Styles for Migration Time Based Calibrations

The report styles available for migration time based calibrations are
limited to Short (quantitative text results) and Full (header, sample
information, instrument conditions, logbook, quantitative results and peak
purity plot).

Calibration using Mobility Correction

Slight changes in buffer composition, run temperature or viscosity, as well
as adsorption to the capillary wall, can influence the Electro Osmotic Flow
(EOF) and cause it to be unstable. The resulting change in the EOF can

create a rather high standard deviation of migration times. Corrections for
mobility can significantly reduce the effect of run-to-run migration time

shifts by monitoring the migration time of a mobility reference peak and
in turn significantly increasing the migration time reproducibility.

The mobility reference peak should be chosen with the following priorities:
* Select peak with the highest signal
* Select the most isolated peak

* The EOF marker or internal standard can also be used as the mobility
reference peak

* Enlarge the search window to always find the mobility reference peak

* If several peaks fall in the search window, the peak with the highest
signal is automatically chosen as the mobility reference peak.
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There are two mobility correction types available:

Effective Mobility  Effective Mobility Correction uses the effective mobilities of all peaks and
Correction  requires the availability of the voltage ramp data together with the
electropherogram. In addition, working with effective mobility correction
allows the true effective mobilities for all sample components to be
determined.

Relative Mobility  Relative Mobility Correction can operate in the absence of voltage data and
Correction would then assume a constant voltage for all measurements.
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CE-MS

Background Subtraction

When you select the Subtract Background (BSB) menu item, the most
recently selected mass spectrum is subtracted from each point in the
current electropherogram. The resulting data is saved in the same
directory and with the same name as the original data file; however, the
file extension is changed to .BSB.

The new data file becomes the current data file and the background
subtracted electropherogram is displayed. A record of the number of
background subtractions that have been performed is kept in the Operator
item of the data file header.

If you view a tabular listing of BSB data, you may observe differences due
to the precision of data representation.

The HELP text files in the LC/MS refer only to LC parameters and not CE. Some features
that are available in the LC/MS software are either not available or not applicable to
CE/MS applications but are used in LC. The function peak matching is not applicable for
CE-MS and is therefore not active. In CE-MS, UV and MS detection occurs at different
effective lengths of the separation capillary. Because of the different resolution at different
effective lengths, peak matching is not possible.

ChemStation Concepts and Workflows 207



9  CE specific Concepts and Functions

Method Subdirectories for different CE Modes

CE

CEC
CEp
CEMS
CEMSp

208

Methods in CE are dependent on CE mode selected. Therefore they are
in different subdirectories in the Method subdirectory:

stored
Stores
Stores
Stores
Stores

Stores

methods for CE
methods for the
methods for the
methods for the

methods for the

mode

CEC mode

CE plus pressure mode
CE MS mode.

CE MS plus pressure mode.
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